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About this guide

The Integrating Sourcing, Contract, and Supplier data with SAP ERP and SAP S/4HANA guide contains information 
about integrating sourcing, contract, and supplier master data between SAP ERP or SAP S/4HANA and the 
following Ariba applications:

● SAP Ariba Sourcing
● SAP Ariba Contracts
● SAP Ariba Supplier Information and Performance Management
● SAP Ariba Supplier Lifecycle and Performance, previously referred to as Ariba Supplier Management

This guide primarily focuses on feature-specific information including configuration information. For installation 
information, see the Installation Guide for Sourcing, Contracts, and Supplier Data Integration with SAP ERP and 
SAP S/4HANA.
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About integrating sourcing, contract, and 
supplier data with SAP ERP and SAP S/4HANA

You can integrate sourcing, contract, and supplier data between SAP ERP or SAP S/4HANA and the following 
applications:

● SAP Ariba Sourcing
● SAP Ariba Contracts
● SAP Ariba Supplier Information and Performance Management
● SAP Ariba Supplier Lifecycle and Performance, previously referred to as Ariba Supplier Management

The following table provides a list of supported integrations and links to the corresponding feature documentation:

Integration feature Documentation

Integrating Ariba Sourcing Master data and bill of 
materials

Integrating master data between SAP ERP and SAP Ariba Sourcing 
[page 11]

Creating purchase info records in SAP ERP from 
Ariba Sourcing awards

Creating purchase info records in SAP ERP from SAP Ariba Sourcing 
awards [page 22]

Integrating contracts from Ariba Contracts Manage­
ment

Integrating contract information with SAP ERP [page 26]

Integrating Ariba Supplier Information and Perform­
ance Management

Integrating Supplier Information and Performance Management with 
SAP ERP and MDG [page 42]

Integrating Ariba Supplier Lifecycle and Perform­
ance integration

Integrating SAP Ariba Supplier Lifecycle and Performance with SAP ERP 
[page 63]

Note
For information about QuoteRequest and QuoteMessage integrations, see the RFQ and Award Integration with 
Ariba Sourcing guide.

For information about the supported versions and integration landscapes for the integrations discussed in this 
guide, see Supported versions and integration landscapes [page 6].

Supported versions and integration landscapes

The following table provides the SAP ERP, SAP S/4HANA on-premise, and SAP Process Integration versions that 
are required for various integration features to work:

6 P U B L I C

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA

About integrating sourcing, contract, and supplier data with SAP ERP and SAP S/
4HANA



Note
To prevent errors for the mandatory target fields containing a combination of NodeFunctions, CopyValue and 
Text Functions when using SAP Process Integration 7.5, refer to the following SAP Notes:

● SAP Note 2209925 -CopyValue function not getting correct output
● SAP Note 2185824-Graphical Mapping combination - 'CopyValue', any Standard Functions from Text 

category and NodeFunctions give wrong output

Feature Introduced in SAP ERP version (Min­
imum requirement)

SAP S/4HANA SAP Process Integra­
tion versions

Master data and mate­
rial master data inte­
gration

SAP Ariba cloud inte­
gration release 7.0

SAP ERP 6.0 
(SAP_APPL 606 
SPS02)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5

Contracts integration SAP Ariba cloud inte­
gration release 7.0

SAP ERP 6.0 
(SAP_APPL 600 
SPS02)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA
Finance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5
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Feature Introduced in SAP ERP version (Min­
imum requirement)

SAP S/4HANA SAP Process Integra­
tion versions

Ariba Supplier Informa­
tion and Performance 
Management integra­
tion

SAP Ariba cloud inte­
gration release 7.0

SAP ERP 6.0 
(SAP_APPL 606 
SPS02)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5

Manufacturer parts list SAP Ariba cloud inte­
gration release 8.0

SAP ERP (SAP_APPL 
600 SP 14)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5
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Feature Introduced in SAP ERP version (Min­
imum requirement)

SAP S/4HANA SAP Process Integra­
tion versions

Bill of materials SAP Ariba cloud inte­
gration release 8.0

SAP ERP (SAP_APPL 
600 SP 14)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5

Ariba Sourcing awards 
integration to create 
Purchase info records

SAP Ariba cloud inte­
gration release 8.0

SAP ERP (SAP_APPL 
617 SP 11)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5
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Feature Introduced in SAP ERP version (Min­
imum requirement)

SAP S/4HANA SAP Process Integra­
tion versions

Supplier Lifecycle and 
Performance

SAP Ariba cloud inte­
gration release 8.0

SAP ERP 6.0 EHP6 SP1 
with SAP Business 
Services Foundation 
731

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5

Service item lines in 
RFQ, Awards, and Con­
tracts

SAP Ariba cloud inte­
gration release 9.0

SAP ERP 6.0 
(SAP_APPL 604 SPS05 
and SAP_BASIS 701 
SP05)

● SAP S/4HANA, 
on-premise edition 
1610

● SAP S/4HANA, 
on-premise edition 
1511

● SAP S/4HANA Fi­
nance
○ SAP Simple 

Finance, on-
premise edi­
tion 1503

○ SAP S/
4HANA Fi­
nance 1605

● 7.1
● 7.3
● 7.31
● 7.4
● 7.5

Installation
For direct connectivity-based integrations, you must download and import the latest transports to SAP ERP or 
SAP S/4HANA. For mediated connectivity-based integrations and integrations that are applicable to SAP Ariba 
Start Sourcing, you must download and import the latest design objects and mappings to SAP Process 
Integration.

For more information about the installation procedure, see the Installation Guide for Sourcing, Contracts, and 
Supplier Data Integration with SAP ERP and SAP S/4HANA guide.

Feature-specific configurations for integration methods are explained in this guide.
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Integrating master data between SAP ERP and 
SAP Ariba Sourcing

This chapter contains the following sections:

In this section:

About master data integration between SAP ERP and SAP Ariba Sourcing [page 11]

How to export master data from SAP ERP to SAP Ariba Sourcing and SAP Ariba Contracts [page 16]

How to export bill of materials from SAP ERP to SAP Ariba Sourcing [page 18]

How to customize master data exports [page 19]

How to include additional information in the SLG1 log files [page 21]

About master data integration between SAP ERP and 
SAP Ariba Sourcing
Buyers using the SAP Ariba Sourcing and SAP Ariba Contracts applications integrated with SAP ERP can export 
master data from SAP ERP to SAP Ariba Sourcing and SAP Ariba Contracts. Master data elements that buyers can 
export from SAP ERP to the SAP Ariba Sourcing and SAP Ariba Contracts applications include organizational data, 
cross application data, and material master data.

You can export master data from SAP ERP to SAP Ariba Sourcing and SAP Ariba Contracts over Direct or 
Mediated Connectivity integration methods. You can export the organizational master data, cross application 
configuration data, and material master data in the full load mode. For material master, you also have an option to 
export the master data in the incremental mode.

When you export the material master data for the first time, choose the full load mode. You can use the 
incremental load for subsequent exports. An incremental export of master data sends all master data records that 
have been added, modified, or deleted since the last export event.

Tip
Material master data contains large volume of information. For best performance, always set filters that specify 
the criteria based on which you can export smaller subsets. For more information on setting filters for material 
master data export, see How to specify filters for master data export [page 17].

The following table lists the master data groups and corresponding master data elements:
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Table 1: Master Data Groups and Elements

Master Data Group Master Data Element

Organizational Data Plant

Organizational Data PurchaseGroup

Organizational Data PurchaseOrg

Organizational Data PlantPurchaseOrg

Organizational Data CompanyCode

Cross Application Configuration Data PaymentTerms

Cross Application Configuration Data IncoTerms

Material Master Material Master

Material Master Item Category

Material Master ERPCommodityCode(Material Group)

When you export material master data, you also receive material master plant association data and material 
master language associations data. Similarly, for Incoterms, you receive the Incoterms language association data 
along with the Incoterms master data.

Every time you export the master data to SAP Ariba Sourcing and SAP Ariba Contracts, the SAP ERP system 
sends a copy of the schema file, which contains the ERP metadata information related to the master data extracts, 
along with the master data.

Enhancements to SAP Ariba Sourcing integration for 
product sourcing 
SAP Ariba cloud integration release 8.0 and higher extends the SAP Ariba Sourcing integration with SAP ERP to 
the following features to enhance the product sourcing process:

● Material Classification [page 12]
● Valid From data for plants [page 13]
● Manufacturer Parts List [page 13]
● Bill of Materials [page 14]

Material classification

Buyers using SAP Ariba Sourcing integrated with SAP ERP can now receive classification data such as class types, 
class names, and characteristics along with the material master data that they export to SAP Ariba Sourcing from 
SAP ERP. The classification values enable you to categorize materials based on their characteristics. Classification 
data also enables you to search and find materials more easily.
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When you export material master data from SAP ERP to SAP Ariba Sourcing, SAP ERP provides the classification 
information in the ItemMasterClassificationInfo.csv file. ItemMasterClassificationInfo.csv 
contains class and classification information along with Classification sequence and material number.

Classification sequence is a combination of the internal object number, class type, class name, and characteristic 
value.

Note
If you need material classification for multiple class types, you must implement the SAP Note 65124-
Classification Change Documents.

To extract material classification data, you need to maintain the following filters in the table /ARBA/TVARV:

● /ARBA/CLASS_TYPE
● /ARBA/CLASS

For information about maintaining these filters, see How to maintain table entries for SAP Ariba Sourcing and SAP 
Ariba Contracts integration with SAP ERP [page 92].

Valid From data for plants

To support the bill of materials integration, SAP ERP now provides the Valid From data along with the plant data in 
the ItemMasterPlantCombo.csv and ItemMasterPlantCombo_Delete.csv files. The ValidFrom field 
contains the date from which the cross-plant material status is valid.

Manufacturer Parts List

When buyers using SAP Ariba Sourcing integrated with SAP ERP export material master data from SAP ERP to 
SAP Ariba Sourcing, SAP ERP also sends the Manufacturer Parts List to SAP Ariba Sourcing.

Manufacturer Parts List is similar to the Approved Manufacturer Parts List (AMPL) in SAP ERP. You can use the 
Manufacturer Parts List to identify the manufacturers for materials of type manufacturer parts (HERS in SAP) and 
the manufacturer part numbers and the corresponding internal part numbers.

The material master data export event now sends the following additional files from SAP ERP to SAP Ariba 
Sourcing:

● ItemMasterAML.csv
● ItemMasterAMLDescriptionLang.csv
● ItemMasterAML_delete.csv
● ItemMasterAMLDescriptionLang_delete.csv

You can specify the material number range as input for reprocessing of failed or missed entries when performing 
incremental upload using SAP Menu Master Data Reports Master Data Report Integration . The 
DateTime stamp is not updated during this incremental upload and the change log table /ARBA/CHANGE_DOCS is 
not cleared.
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Note
ItemMasterAML_delete.csv and ItemMasterAMLDescriptionLang_delete.csv are available only when 
you do an incremental export.

Bill of Materials

Buyers using SAP Ariba Sourcing integrated with SAP ERP can now export bill of materials (BOM) from SAP ERP 
to SAP Ariba Sourcing. A bill of materials provides a structured list of parts or components that form a product.

The bill of materials information that SAP ERP exports to SAP Ariba Sourcing includes information about material, 
plant, validity, component quantity, unit of measure, and so on. For more information about the master data 
elements in bill of materials, see the Mapping Workbook.

SAP Ariba cloud integration exports only single-level bill of materials from SAP ERP to SAP Ariba Sourcing. 
However, SAP Ariba Sourcing can link the related bill of materials components and complete the bill of materials 
explosion.

SAP ERP uses SOAP messages to send bill of materials data to SAP Ariba Sourcing. SAP Ariba Sourcing 
integration with SAP ERP does not support bill of materials explosion. So, only single-level bill of materials is 
exported to SAP Ariba Sourcing from SAP ERP.

Starting SAP Ariba cloud integration release 8.0 HF19, buyers can include information about the bill of materials 
and approved manufacturer list for material items in the SLG1 log files. To include this information, SAP Ariba 
provides an optional parameter /ARBA/LOG_MASTERDATA that buyers can specify in the /ARBA/TVARV table.

When buyers run the /ARBA/MASTER_DATA_EXPORT program for the incremental load event, SAP Ariba provides 
information on the bill of materials number. The bill of materials number, alternative bill of materials number, and 
the material item number is separated with the '|' symbol in the SLG1 log file. For example, 00000014|01|P-100.

When buyers run the /ARBA/MASTER_DATA_EXPORT program for the full or incremental load event, SAP Ariba 
provides information on the records that have been extracted or deleted for the material items with the approved 
manufacturer list information.

For more information, see How to include additional information in the SLG1 log files [page 21].

Area menu and transaction codes for master data and bill 
of materials export

You can use the /n/ARBA/OND_SRC area menu to access the master data and bill of materials export programs. 
The following table lists the area menu items and transaction codes for master data export and bill of material 
export:
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Exports Area Menu

Master data including material master, 
material classification, and Manufacturer 
Parts List

SAP Menu Master Data Reports

Master Data Report Integration

/ARBA/MASTER_DATA

Bill of Materials SAP Menu Master Data Reports

Master Data BOM Integration

/ARBA/BOM_MASTER_DATA

Enabling this feature
This feature is enabled for all customers. Contact your Ariba Account Manager for more information on integration 
services.

For information about configuring this feature, see Importing Ariba components and configuring integration 
methods [page 91].

Prerequisites
● Install the latest Ariba components. For more information, see How to import Ariba components [page 91].
● Maintain the entries in /ARBA/AUTH_PARAM and /ARBA/TVARV tables. For more information, see How to 

maintain table entries for SAP Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 92].
● Configure Direct [page 99] or Mediated [page 106] Connectivity.
● Export the plant, plant purchase org, purchase org, and purchase group master data before you export 

material master data.
● Export the material master data and ensure that the material master data synchronization between SAP Ariba 

Sourcing and the Arches database is over before you run the bill of materials master data export.

Limitations
● You cannot use Ariba Integration Tool Kit-based connections for exporting master data from SAP ERP 

systems to SAP Ariba Sourcing and SAP Ariba Contracts.
● SAP Ariba Sourcing does not support deletion of class information. If you delete a class associated with 

material master data in SAP ERP and run an incremental export, the incremental export does not modify the 
corresponding records in SAP Ariba Sourcing to indicate that the class associated with the material is deleted. 
This might cause the classification data in SAP Ariba Sourcing and SAP ERP to be out of sync if some records 
have been deleted in SAP ERP.

Tip
You could edit the material master data to remove (wipe) the classification information and then run an 
incremental export to update the corresponding data in SAP Ariba Sourcing.
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● Bill of materials integration does not support client certificate-based authentication.

How to export master data from SAP ERP to SAP 
Ariba Sourcing and SAP Ariba Contracts

Prerequisites

● Install the latest Ariba components. For more information, see How to import Ariba components [page 91].
● Configure Direct [page 99] or Mediated [page 106] Connectivity.
● Maintain the /ARBA/EXTERNAL_SID parameter in the /ARBA/TVARV table. The value you set for /ARBA/

EXTERNAL_SID must match the system ID you configured in the Master Data Manager External System 
Configuration  panel of the Ariba application.
For more information about configuring /ARBA/EXTERNAL_SID, see How to maintain table entries for SAP 
Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 92].

Procedure

1. From the SAP ERP interface, go to the ARBA/MASTER_DATA_EXPORT program. Alternatively, run the 
transaction code /ARBA/MASTER_DATA.

The Master Data Export page appears.
2. From the Scope of Procurement Solution options, Select Contracts and Sourcing.
3. From the Load Options, select one of the following:

○ Full Load. Exports all the master data records that are available for the master data type that you select in 
the next step.

○ Incremental Load. Exports the master data records that have been updated since the last master data 
export event. You can export only material master data in the incremental load setting..

4. If you selected the Full Load option in the previous step, check one or more of the following master data 
element check boxes:

○ Plant
○ PurchaseOrg
○ CompanyCode
○ PurchaseGroup
○ PlantPurchaseOrg
○ Payment Terms
○ IncoTerms
○ Material Master
○ ItemCategory
○ ERPCommodityCode (Material Group)
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If you selected the Incremental Load option in the previous step, only the Material Master option is available 
for selection. To export material master data in the incremental mode, check Material Master.

Tip
Material master data contains large volume of information. For best performance, always set filters that 
specify the criteria based on which you can export smaller subsets. For more information about specifying 
filters, see How to specify filters for master data export [page 17].

5. To export the selected master data, click the Execute button.

How to specify filters for master data export

Context

Filters enable you to specify the criteria based on which you want to export master data. Master data elements 
such as material master data might contain large amount of data. For best performance, always set filters that 
specify the criteria to export smaller subsets.

Procedure

From SAP ERP, run the transaction code sm30 and specify the filtering criteria for the following variables in the /
ARBA/TVARV table:

Tip
Material master data contains large volume of information. For best performance, always set filters such as /
ARBA/SPLIT_NOMREC that specify the criteria based on which smaller subsets are exported.

○ /ARBA/MATERIAL_MASTER_EXPORT
○ /ARBA/MATERIAL_LANG_EXPORT
○ /ARBA/ITEMCATEGORY_EXPORT
○ /ARBA/INCOTERMS_EXPORT
○ /ARBA/SPLIT_NOMREC. Specify the number of records you need to export in a batch. The recommended 

value for this parameter is 40,000 records.
○ /ARBA/DC_WAITTIME. Specify the number of seconds that SAP ERP should wait between two Direct 

Connectivity calls to the SAP Ariba application. The default value is one second. This parameter is important 
when the export contains multiple batches of records based on the /ARBA/SPLIT_NOMREC configuration.

For more information about configuring /ARBA/SPLIT_NOMREC and /ARBA/DC_WAITTIME, see How to maintain 
table entries for SAP Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 92].
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How to export bill of materials from SAP ERP to SAP 
Ariba Sourcing
Prerequisites

● Install the latest Ariba components. For more information, see How to import Ariba components [page 91].
● Configure Direct [page 99] or Mediated [page 106] Connectivity.
● Maintain the following parameters in the /ARBA/TVARV table.
● ○ Maintain the /ARBA/EXTERNAL_SID parameter. The value you set for /ARBA/EXTERNAL_SID must 

match the system ID you configured in the Master Data Manager  External System Configuration
panel of the SAP Ariba application.

○ If you need to filter the bill of materials data that SAP ERP exports to SAP Ariba Sourcing, configure the /
ARBA/BILLOFMATERIALS_EXPORT parameter in the /ARBA/TVARV table.

○ If you need to split the bill of materials master data export into multiple batches, configure the /ARBA/
SPLIT_NOMREC parameter in the /ARBA/TVARV table. If you configure /ARBA/SPLIT_NOMREC, you must 
also configure the /ARBA/DC_WAITTIME parameter.

For more information about configuring the /ARBA/TVARV table , see How to maintain table entries for SAP 
Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 92].

Context

You can export bill of materials data from SAP ERP to SAP Ariba Sourcing. You can either do a full load export or 
an incremental export.

Procedure

1. Go to the transaction code /ARBA/BOM_MASTER_DATA. Alternatively, go to the area menu, /n/ARBA/
OND_SRC. From the SAP Easy Access Transaction Code for Ondemand Sourcing window, click SAP Menu

Master Data Reports Master Data BOM Integration .

In the Export All Master Data Required for On-Demand App Using Web Service window appears.
2. In the Export All Master Data Required for On-Demand App Using Web Service window, specify the 

following:

○ Select Full Load or Incremental Load.
○ Check the Bill of Material check box.

If you selected Incremental Load, you can optionally specify a date range for which period you want to 
export the bill of materials.

Note
If you specify a date range for the incremental update, SAP ERP does not update the timestamp in the /
ARBA/INCR_DTTIM table. When you do an incremental update next time without specifying a date 
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range, SAP ERP exports all records that have been added or modified since the last incremental export 
for which the timestamp is available in /ARBA/INCR_DTTIM.

3. Click Execute.

SAP ERP displays the status of the bill of materials export to SAP Ariba Sourcing. Note that for full load 
exports that contain multiple batches, SAP ERP returns only the high-level status in the Reports page.

How to customize master data exports
To customize master data export, you can modify the following methods in the /ARBA/MASTER_DATA BAdI:

● PUBLISH_PLANT
● PUBLISH_PURCHASE_ORGANIZATION
● PUBLISH_COMPANYCODE
● PUBLISH_PURCHASE_GROUP
● PUBLISH_PLANT_PURCHASE_ORG
● PUBLISH_PAYMENT_TERMS
● PUBLISH_INCOTERMS
● PUBLISH_MATERIALMASTER
● PUBLISH_ITEMCATEGORY
● PUBLISH_MATERIAL_GROUP

If you want to add additional master data elements to the extract, you must update the /ARBA/FIELD_MAP table 
to include the mapping for the newly-added fields.

How to customize material master data exports

You can implement the /ARBA/MASTER_DATA BAdI to customize the material master data exports. Customization 
of the export enables you to add or modify fields in an export.

Customization of material master data exports involve the following steps:

1. Modifying the structure [page 19]
2. Implementing the logic [page 20]
3. Updating the /ARBA/FIELD_MAP table [page 20]

Modifying the structure

Modify the structure corresponding to the .CSV file that you need to customize.

1. To modify a structure, go to /nse11 transaction code.
2. In the Data Type field, enter the name of the structure that you want to modify and click Display.
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You can customize the following structures for material master data export including material classification 
and Manufacturer Parts List:
○ /ARBA/MATERIAL_ONLY_INFO
○ /ARBA/MATERIAL_PLANT
○ /ARBA/MATERIAL_LANG
○ /ARBA/MAT_CLASS_INFO
○ /ARBA/MATERIAL_ONLY_AML

3. From the Dictionary: Display Structure window, click Append Structure to append new fields.

Implementing the logic

Implement the BAdI logic to ensure that the custom fields you created in the previous step get populated when 
you export master data from SAP ERP to SAP Ariba Sourcing.

To implement the BAdI logic, go to the se18 transaction code and enter the BAdI name. The following table 
contains the BAdI details for material master export including material classification and Manufacturer Parts List:

BAdI name /ARBA/MASTER_DATA

BAdI interface name /ARBA/IF_EXP_MASTER_DATA

Method PUBLISH_MATERIALMASTER

Parameters MATERIALINFO for extending material general data.

MATERIALPLANTINFO for extending material plant data.

MATERIALLANGINFO for extending material description 
data.

MATERIALCLASSINFO for extending material classification 
data.

MATERIALAML for extending Manufacturer Parts List data.

Type /ARBA/MATERIAL_ONLY_T

/ARBA/MATERIAL_PLANT_T

/ARBA/MATERIAL_LANG_T

/ARBA/MAT_CLASS_INFO_T

/ARBA/MATERIAL_ONLY_AML_T

Updating the /ARBA/FIELD_MAP table

After you implement the BAdI, you must maintain the mapping between SAP fields and SAP Ariba fields in the /
ARBA/FIELD_MAP table. To maintain /ARBA/FIELD_MAP, go to transaction code sm30.
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In the /ARBA/FIELD_MAP, set the solution to SAP Ariba Sourcing and select the structure that you want to 
customize for the newly-added custom fields. For the newly-added custom fields, set Field SAP and Field Ariba 
values. Ensure that the value you set for Field Ariba matches with the corresponding field in SAP Ariba Sourcing.

If you do not maintain the mapping in /ARBA/FIELD_MAP, the .CSV file uses the SAP field value as the column 
header. This might cause the integration to fail if the SAP field name does not match with an Ariba field name.

Note
By default, the /ARBA/FIELD_MAP table contains standard field mapping between SAP ERP and SAP Ariba 
Sourcing as set by the latest sourcing transports you imported. Do not delete the default entries in the /ARBA/
FIELD_MAP table.

How to include additional information in the SLG1 
log files

Context

Starting SAP Ariba cloud integration release 8.0 HF19, buyers can include information about the bill of materials 
and approved manufacturer list for material items in the SLG1 log files. To include this information, SAP Ariba 
provides this parameter /ARBA/LOG_MASTERDATA that buyers need to specify in the /ARBA/TVARV table.

Procedure

1. Run the transaction code SM30.

2. Go the /ARBA/TVARV table and maintain the parameter /ARBA/LOG_MASTERDATA.

3. Maintain the following values:

○ Variable Name: /ARBA/LOG_MASTERDATA
○ Field name: Leave it empty.
○ Selection cat. : P
○ Number: 0 (zero)
○ Char 20: Leave it empty.
○ Char 20 : Leave it empty.
○ INCL/EXCL: I
○ Option:EQ
○ Selection value: For example, X.
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Creating purchase info records in SAP ERP 
from SAP Ariba Sourcing awards

This chapter contains the following topics:

In this section:

About the integration support for creating purchase info records in SAP ERP from SAP Ariba Sourcing awards 
[page 22]

How to customize purchase info record fields [page 23]

How to maintain the pricing conditions [page 24]

How to schedule the /ARBA/CR_PIR_CREATE program [page 24]

Installing and configuring the integration support for creating purchase info records in SAP ERP from SAP 
Ariba awards [page 25]

About the integration support for creating purchase 
info records in SAP ERP from SAP Ariba Sourcing 
awards

Integration with SAP Ariba Sourcing enables SAP ERP to create purchase info records based on awards 
information from SAP Ariba Sourcing.

You can schedule the /ARBA/CR_PIR_CREATE program to fetch awards information from SAP Ariba Sourcing at 
regular intervals. When /ARBA/CR_PIR_CREATE requests SAP Ariba Sourcing for awards information, the request 
also contains the date and time of the last request sent to SAP Ariba Sourcing. In response to the request, SAP 
Ariba Sourcing sends information about awards that have been added or modified since the last time SAP Ariba 
Sourcing sent awards information to SAP ERP.

When SAP ERP receives awards information from SAP Ariba Sourcing, SAP ERP creates a purchase info record for 
each of the line items in an SAP Ariba Sourcing award. When a purchase info record is successfully created, SAP 
ERP sends the purchase info record (PIR) number to SAP Ariba Sourcing. If a purchase info record is already 
available for a line item and if there is change in any of the values associated with that item in the newly-received 
award information, SAP ERP modifies the corresponding purchase info record.

If SAP ERP encounters errors while creating or modifying a purchase info record, SAP ERP sends an error 
message to SAP Ariba Sourcing. The error message contains the details of the error.

SAP ERP supports pricing conditions and validity periods in purchase info records. A purchase info record in SAP 
ERP can have one or more pricing conditions that have one or more validity periods.

You can implement the /ARBA/PURINFREC BAdI to map additional fields to the purchase info record.
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Prerequisites

● Install the latest SAP Ariba Sourcing transports.
● If you want to use Mediated Connectivity, install the latest TPZ files.
● Set up Direct or Mediated Connectivity between SAP ERP and SAP Ariba Sourcing.
● Maintain parameters in AUTH_PARAM and TVARV tables. For more information, see How to maintain table 

entries for SAP Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 92].
● Maintain pricing conditions mapping between SAP Ariba and SAP ERP in th /ARBA/PRC_CD_MAP table. For 

more information, see How to maintain the pricing conditions [page 24].

Enabling this Feature

This feature is enabled for all customers. For more information about configuring this feature, see Installing and 
configuring the integration support for creating purchase info records in SAP ERP from SAP Ariba awards [page 
25].

Limitations

● Deletion of purchase info records is not supported.
● Scale-based conditions are not supported.
● Client certificate-based authentication is not supported for Direct and Mediated Connectivity.

How to customize purchase info record fields
You can implement the the BAdI,/ARBA/PURINFREC, to customize the fields in the purchase info records that are 
created from the SAP Ariba awards. The BAdI, /ARBA/PURINFREC, contains the following two methods:

● MAP_PIR for mapping additional fields to a purchase info record.

GET BADI go_badi.     IF go_badi IS BOUND.
        CALL BADI go_badi->map_pir
            CHANGING
                eina = gw_eina
                eine = gw_eine.     ENDIF.

● POST_PROCESSING for customizations after creating the purchase info record and sending the confirmation 
to SAP Ariba.

GET BADI go_badi.     IF go_badi IS BOUND.
        CALL BADI go_badi->post_processing
            CHANGING    
                eina = gt_eina
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                eine = gt_eine.     ENDIF.

How to maintain the pricing conditions

Context

As a prerequisite to creating purchasing info records in SAP ERP from SAP Ariba Sourcing awards, you must 
maintain the pricing conditions in table /ARBA/PIR_CD_MAP.

Procedure

1. In the SAP ERP main screen, navigate to System Services Table Maintenance Extended Table 
Maintenance .

Alternatively, go to transaction code sm30.

The Maintain Table Views initial screen appears.
2. Enter /ARBA/PIR_CD_MAP in the Table/View field and click Maintain.

Maintain values for the following fields:
○ Ariba Condition Type.
○ SAP Condition Type.

For example, the SAP Condition Type value for Ariba Condition Type GROSSPRICE is PB00. Similarly, for Ariba 
Condition Type DISCOUNTAMOUNT, the SAP Condition Type value is R002.

3. Click Save.

How to schedule the /ARBA/CR_PIR_CREATE 
program

From SAP ERP, you can run the transaction code sm36 and specify the program name, /ARBA/CR_PIR_CREATE, 
and the interval at which you want to run the program.
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Installing and configuring the integration support for 
creating purchase info records in SAP ERP from SAP 
Ariba awards
For information about installing Ariba components and setting up connectivity settings, see Importing Ariba 
components and configuring integration methods [page 91].
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Integrating contract information with SAP ERP

This chapter contains the following sections:

In this section:

About the integration of contract information [page 26]

Customizing contract integration [page 31]

Installing and configuring the integration of contract information with SAP ERP [page 32]

About the integration of contract information
Buyers using Ariba Network adapter for SAP NetWeaver and SAP Ariba Contracts can integrate the contract 
information from SAP Ariba Contracts with SAP ERP. SAP ERP 6.0 EhP 0 and later versions and SAP NetWeaver PI 
7.1, 7.3, 7.4, PO 7.3, and PO 7.4 versions support integration of contract information between SAP Ariba Contracts 
and SAP ERP.

When you create a new contract or a contract amendment on SAP Ariba Contracts, the contract is sent to the 
Ariba Network. From Ariba Network, the SAP Process Integration communication channel picks up the contract 
and sends the document to SAP ERP. SAP ERP creates an outline agreement based on the header and line-item 
data of the contract received from SAP Ariba Contracts.

When the outline agreement is created in SAP ERP, SAP ERP sends the SAP document number and outline 
agreement line item numbers with mapping to the corresponding line items in the SAP Ariba contract. If the 
contract integration fails or encounters errors, SAP ERP also sends error messages to SAP Ariba Contracts.

If you update a contract in SAP Ariba Contracts after an outline agreement has been created in SAP ERP, SAP 
Ariba Contracts sends the contract amendment message to SAP ERP. The contract amendment message also 
contains the SAP document number of the corresponding outline agreement. When SAP ERP receives the 
contract amendment along with the SAP document number for an outline agreement, SAP ERP updates the 
corresponding outline agreement.

The Header and Line Item Fields in an Outline Agreement section contains the header and line item fields in an 
outline agreement. Note that some of the fields cannot be modified in the outline agreement after an outline 
agreement has been created. You can add additional fields by creating the necessary mapping in the 
corresponding cXML.

Note
The contract integration is unidirectional, and all updates should be made only in the SAP Ariba Contracts. Any 
change that you make in the outline agreement from SAP ERP will remain in SAP ERP and might cause conflict 
with the contract in SAP Ariba Contracts.

If you delete a contract in SAP Ariba Contracts, SAP ERP marks the line items in the outline agreement as deleted.
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Enabling this Feature

This feature is enabled for all customers. However, support for this feature will be made available only as part of 
the upcoming Ariba Application 2016 release. Contact your SAP Ariba Account Manager for more information on 
integration services.

Prerequisites

Before you can integrate contract information from SAP Ariba Contracts, you must complete the following tasks:

● Install the latest versions of the SAP Process Integration TPZ and SAP ERP transports.
● Set up master data integration between SAP Ariba Contracts and SAP ERP. The master data integration 

provides the master data that is required for the contract integration between SAP Ariba Contracts and SAP 
ERP.

● Ensure that you configure the value mappings between the business system and logical system names for 
multiple ERP systems. Ensure that you enable the multi-ERP mode on your SAP ERP system. For more 
information, see the Setting up Ariba Network adapter for SAP NetWeaver guide.

● On Ariba Network, create a system ID for your ERP system. The System ID that you create on Ariba Network 
must match the System ID that you maintain on the SAP ERP system and SAP Ariba Contracts. For this newly 
created System ID, create one end point for your SAP ERP system and another end point to connect to your 
SAP Ariba Contracts system. For more information, see the Buyer Administration Guide.

● Configure Ariba Network adapter for SAP NetWeaver.
● Maintain value mappings for SAP Ariba Contracts and SAP ERP in the Integration Builder.
● Maintain pricing conditions mapping between SAP Ariba and SAP ERP in the /ARBA/PRC_CD_MAP table.

Limitations

● Attachments in contracts that are created in SAP Ariba Contracts are not included in the outline agreement 
generated in SAP ERP.

● Ariba Network adapter for SAP NetWeaver does not support contracts with service items having more than 
one level of parent and child hierarchy.

● SAP Ariba Sourcing does not support deletion of the entire contract after it has been published. You can only 
delete the line items in a contract.

Related Information

Integrating master data between SAP ERP and SAP Ariba Sourcing [page 11]
Customizing contract integration [page 31]
Installing and configuring the integration of contract information with SAP ERP [page 32]
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Header and line item fields in an outline agreement

The following table lists the header and line-item elements that are included in an outline agreement. The Change 
Contract Impact column indicates which fields might get updated in the outline agreement if the buyer updates a 
contract in SAP Ariba Contracts.

Table 2: Header and Line Item Fields in an Outline Agreement

Fields Change Contract Impact

Header Elements

Purchasing Organization Cannot be modified

Purchasing Group Cannot be modified

Company Code Cannot be modified

Currency Cannot be modified

ISO Code for Currency Cannot be modified

Payment Term Can be modified

Ariba Document Number Can be modified

SAP Document Type Cannot be modified

Vendor Cannot be modified

Start Date Can be modified

End Date Can be modified

Target Value Can be modified

Line-Item Elements

Item Number Cannot be modified

Item Category Cannot be modified

Material Code Cannot be modified

Description Can be modified

Quantity Can be modified

UOM Cannot be modified if the contract contains Material Code

ISO Codes for Unit of Measure Can be modified

Plant Cannot be modified
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Fields Change Contract Impact

Unit Price Can be modified

Discount Amount Can be modified

Discount Percentage Can be modified

Surcharge Percentage Can be modified

Incoterms 1 Can be modified

Incoterms 2 Can be modified

Material Group Cannot be modified if the contract contains Material Code

Account Assignment Category Can be modified

ERP RFQ Number Can be modified

ERP RFQ Line Number Can be modified

ERP PR Line Number Can be modified

ERP PR Number Can be modified

Notes About Header and Line Item Elements

● Only Standard Material is supported for Item Category field.
● Incoterms 1 maps to Incoterms Code, and Incoterms 2 maps to Location. Incoterms 2 is a free text field of 

maximum 26 characters.
● For Account Assignment Category, SAP ERP requires the accounting data. SAP Ariba Contracts does not 

provide accounting data in contracts. SAP ERP obtains the accounting data from one of the following sources:
○ Purchase requisition if the reference number to the purchase requisition is available.
○ Request for quotation if the reference number to the RFQ is available.
○ Material master if the material code is available.

If none of these is available, SAP ERP marks the accounting data fields as "U" to indicate that the information is 
unknown.
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SAP NetWeaver Process Integration objects for contract 
integration

Objects for create or change contract requests

Process Integration object Name

Software component version ARIBA_SOURCING_ADAPTER, CI9 of ariba.com

Note
For customizations that you implement, use the software 
component ARIBA_SOURCING_CUSTOM_ADAPTER, 1.0 of 
ariba.com

Namespace http://ariba.com/xi/ASN/ContractCreatReq

Service interface MI_ContractCreateReq_Async_In

MI_ContractCreateReq_Async_Out

Communication channel template CCT_SourcingContractReq_cXML_Sender

Process Integration scenarios AR_ContractRequest_Send

Message mappings MM_ContractRequest_to_PurchasingContractER
PCreateRequest

MM_Custom_ContractRequest_to_PurchasingCon
tractERPCreateRequest 

Operation mapping IFM_ContractRequest_to_PurchasingContractE
RPCreateRequest

Target in message mapping PurchasingContractERPCreateRequestConfirma
tion_In
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Objects for contract status response

Process Integration object Name

Software component version ARIBA_SOURCING_ADAPTER, CI9 of ariba.com

Note
For customizations that you implement, use the software 
component ARIBA_SOURCING_CUSTOM_ADAPTER, 1.0 of 
ariba.com

Namespace http://ariba.com/xi/ASN/ContractCreatRes

Service interface MI_ContractCreateRes_Async_In

MI_ContractCreateRes_Async_Out

Communication channel template CCT_ContractStatusUpdateRequest_cXML_Recei
ver

Process Integration scenario AR_ContractStatusUpdate_Receive

Message mappings MM_Custom_PurchasingContractERPCreateConfi
rmation_to_ ContractStatusUpdateRequest

MM_PurchasingContractERPCreateConfirmation
_to_ ContractStatusUpdateRequest

Operation mapping IFM_PurchasingContractERPCreateConfirmatio
n_to_ ContractStatusUpdateRequest

Customizing contract integration
The BAdI /ARBA/SRCNG_CONTRT_CREATE_RESP enables you to customize the integration of contract information 
with SAP ERP. /ARBA/SRCNG_CONTRT_CREATE_RESP has the following methods associated with it:

● INBOUND_PROCESSING. For inbound request.
● OUTBOUND_PROCESSING. For outbound response.

To customize your implementation, you can follow the standard procedure for enhancing the Enterprise Service 
(ES). After you make the changes, regenerate the proxy and map the newly-added fields to the BAdI.
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Installing and configuring the integration of contract 
information with SAP ERP
The following sections provide information about installing and configuring the integration of contract information 
with SAP ERP.

How to import Ariba components

Context

Import the latest transports to SAP ERP and the design objects to SAP Process Integration.

Procedure

For information about installing Ariba components and setting up connectivity settings, see Importing Ariba 
components and configuring integration methods [page 91].

How to configure Process Integration value mappings for 
contract integration

Context

You must maintain the following Process Integration value mappings in the Integration Builder.

Procedure

1. From the Integration Builder main window, go to Tools Value Mapping .
2. Set the mappings as shown in the following table:

Ariba SAP

Agency ACM_CONTRT_TYPE SAP_CONTRT_TYPE

Scheme SourcingContract SourcingContract
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Ariba SAP

Value 1 Quantity MK

Value 2 Value WK

Group Name DocType DocType

Ariba SAP

Agency XI_Global XI

Scheme DeliveryBasedIV DeliveryBasedIV

Value IsGRBasedIV False

Group Name DeliveryBasedIV DeliveryBasedIV

How to maintain the pricing conditions

Context

As a prerequisite to the integration of contract information with SAP ERP, you must maintain the pricing 
conditions in table /ARBA/PRC_CD_MAP.

Procedure

1. In the SAP ERP main screen, navigate to System Services Table Maintenance Extended Table 
Maintenance .

Alternatively, go to transaction code sm30.

The Maintain Table Views initial screen appears.
2. Enter /ARBA/PRC_CD_MAP in the Table/View field and click Maintain.

Maintain values for the following fields:
○ Procedure. Specify the calculation schema, for example RM0000.
○ Ariba Pricing Condition. Specify the pricing condition, such as RA00 and RB00, for the Ariba application.

Ariba Pricing Condition Type SAP Pricing Condition Type

GPCD Corresponding gross price condition type.
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Ariba Pricing Condition Type SAP Pricing Condition Type

RA00 Corresponding discount percentage condition type.

RB00 Corresponding discount value condition type.

ZA00 Corresponding surcharge percentage condition type.

ZB00 Corresponding surcharge value condition type.

Note
If you do not specify a calculation schema, the mapping remains relevant for any calculation schema that 
does not have any mapping associated with it.

3. Click Save.

How to configure communication channels for the contract 
integration scenario

Context

Configure the communication channel CC_SourcingContractReq_cXML_Sender under the 
AR_ContractRequest_Send configuration scenario.

Procedure

1. Under Communication Channel, double-click |BS_ASN| CCT_SourcingContractReq_cXML_Sender to open 
it, or right-click and select Open.

2. In the Parameters tab, set the parameters in the Authentication section to match your Ariba Network buyer 
account configuration.

Note
If you created the channel by copying from an existing channel, you need to change the request type to 
Contract Request in the Inbound Request Type field.

If required, adapt the other parameters. For more information about the cXML Adapter parameters, see the cXML 
Adapter Parameters section in the Setting up Ariba Network adapter for SAP NetWeaver.
3. Save the changes.
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Configuring contract integration scenario

You must configure the integration scenario for the contract transaction in the Integration Directory to integrate 
contracts from SAP Ariba Contracts with SAP ERP. All the steps of a configuration scenario section must be 
completed to fully configure a scenario.

Workflow

Note
Ensure that the design package is imported into your system and ready before you run these steps. The 
following steps assume that the different Business Systems are defined in the SLD. For more information about 
configuring the SLD, see the “About Configuring the System Landscape Directory” section in the Setting up 
Ariba Network adapter for SAP NetWeaver guide.

To configure the contract integration scenario:

1. Transfer the Integration Scenario from the Integration Repository to the Integration Directory.
2. Configure the Integration Scenario.
3. Configure the Communication Channels.
4. Activate the new configuration.

How to transfer the contract integration scenario

Context

The first step to configure the integration scenario for the contracts transaction is to transfer to the Integration 
Directory, the integration scenario loaded into the Integration Repository when the design is imported.

Procedure

1. From the SAP NetWeaver Process Integration main page, select the Integration Directory Integration 
Builder , and then login into Configuration: Integration Builder application.

2. In the Integration Builder menu, select Tools Apply Model from ES Repository .
3. In the first screen of the Transfer Model from ES Repository wizard, Select Process Integration Scenario, 

click the Name field, and then click the Display Input Help drop down list and select Input Help. For inbound 
requests, select the following Process Integration Scenario from the Enterprise Services Repository screen:

○ Name: AR_ContractRequest_Send.
○ Namespace: http://ariba.com/xi/ASN/ContractCreatReq
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○ Software Component Version: ARIBA_SOURCING_ADAPTER CIx of ariba.com.

Tip
For customizations that you implement, use the software component 
ARIBA_SOURCING_CUSTOM_ADAPTER 1.0 of ariba.com.

Alternatively, for the Status Response, select the following values:
○ Name: AR_ContractStatusUpdate_Receive.
○ Namespace: http://ariba.com/xi/ASN/ContractCreatRes
○ Software Component Version: ARIBA_SOURCING_ADAPTER CIx of ariba.com

Tip
For customizations that you implement, use the software component 
ARIBA_SOURCING_CUSTOM_ADAPTER 1.0 of ariba.com.

4. Click Continue.
5. If required, change the name of the scenario for the Integration Directory.
6. Click Finish.

Results

After the transfer is complete, the Model Configurator window appears.

About configuring the contract integration scenario

After you select the Integration Scenario, you must configure it using the following steps:

1. Assign the Model.
2. Assign Components.
3. Configure Connections.
4. Generate Configuration Objects.

How to select the model for the scenario

Procedure

In the Model Configurator window, click the Select Component View button, and then click Apply to select the 
unique component view that is selected by default.
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Next Steps

After you select the component view, you must assign components to the application components of the selected 
integration scenario.

How to assign components for the contract integration scenario

Procedure

1. In the Model Configurator, click the Assign Component button.
2. In the Assign Components window, select the Business System Components for A2A tab to assign 

components for Ariba Network.
3. Click on the Insert Line button ('+') to add a component entry in the table if no component entry line is 

present.
4. Click on the row under the Communication Component column, then click on the Value List drop down and 

select Value List <F4>. Select the communication component name, for example, BS_ASN, from the selection 
list and click Apply.

5. Click the Next Role button (the right arrow) to go to the next screen in the window.
6. Click on the Insert Line button ('+') to add a service entry in the table
7. Click on the row under the Communication Component column, then click on the Value List drop down and 

select Value List <F4>. Select the communication component name, for example, BS_SAPR3_50, from the 
selection list and click Apply.

For Multi ERP implementation add the multiple business services defined for your multiple SAP ERP systems by 
repeating the steps 6 and 7.
8. Click the Save Settings button to save the changes.

Next Steps

After assigning services, you must activate sender/receiver relations for the individual connections in the 
Integration Scenario and specify Communication Channels that are relevant for the sender/receiver relations.

How to configure connections for the contract integration scenario

Procedure

1. In the Model Configurator, click the Configure Connections button. You must assign Communication 
Channels to set up the connections.

2. In the Connections from Component Assignment tab in the Configure Connection window, click the empty 
Communication Channel cell corresponding to BS_ASN in the Sender Business System Components table.
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3. Click the New Communication Channel button (the icon at the top left), and then select Create 
Communication Channel with Template to start the Create Communication Channel wizard.

4. Click on Continue, and in the next page click the Name field, then click the Display Input Help drop down list 
and select Input Help. Select the following Communication Channel Template:

○ Name: CCT_SourcingContractReq_cXML_Sender for inbound. 
CCT_ContractStatusUpdateRequest_cXML_Receiver for status reponse.

○ Namespace: http://ariba.com/xi/ASN/ContractCreatReq for inbound. http://
ariba.com/xi/ASN/ContractCreatRes for status response.

○ Software Component Version: ARIBA_SOURCING_ADAPTER CIx of ariba.co.

Tip
For customizations that you implement, use the software component 
ARIBA_SOURCING_CUSTOM_ADAPTER 1.0 of ariba.com.

5. Click Continue, modify the channel name to, for example, CC_ContractReqCreate_cXML_Sender and then 
click Finish.

6. In the Connections from Component Assignment tab in the Configure Connection window, click the empty 
Communication Channel cell corresponding to BS_SAPR3_50 in the Receiver Business System 
Components table.

The IDoc receiver Communication Channel needs to be created once for each Business System corresponding to 
your SAP ERP. For more information about how to create the IDoc receiver Communication Channel, see the 
“Creating Communication Channels for SAP ERP” section in the Setting up Ariba Network adapter for SAP 
NetWeaver guide.
If a Communication Channel already exists you need to use it.
7. Select the communication channel, for example, CC_Proxy_Receiver created for XI receiver adapter, 

corresponding to the SAP ERP Business System from the selection list.
For Multi ERP implementation, repeat the steps 6 and 7 for all the entries of the Business Systems corresponding 
to your SAP ERP instances.

Tip
If you have already created and configured a Receiver channel for BS_ASN for another transaction, you can 
create the communication channel by copy from a channel already configured.

Note
The communication channels for SAP ERP Sender system are not required.

8. Click the Activate All Connections button, and then click OK in the dialog box.
9. Click the Save Settings button to save the changes.
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How to generating objects for the contract integration scenario

Context

After making all the configuration settings in the wizard, you must generate the objects. Generation creates the 
configuration objects if they do not yet exist. If they do already exist, they will be reused and enhanced, if required. 
You can also simulate generation for test purposes.

Procedure

1. In the Model Configurator, click the Create Configuration Object button.
2. In the Create Configuration Object window, make the following settings:

○ General: Generation (select the radio button for this option)
○ Scope of Generation: Select all the check boxes – Receiver Determination, Interface Determination, 

and Sender/Receiver Agreement.
3. Select the Create New radio button under Change List for Generated Objects and use the proposed name or 

modify it.
4. Click Start to begin generating objects.
5. After the object generation is complete, click Apply to save the new configuration settings. Close the log that is 

created without saving. You can save it, if required.

How to configure receiver determination settings for the contract 
integration scenario

Context

Configure the receiver determination settings manually, for the receiver MI_ContractCreateReq_Async_Out 
under the AR_ContractRequest_Send integration scenario. Retain the default settings for the other receivers.

Note
This configuration is required only for Multi-ERP implementations.

Procedure

1. Expand Receiver Determination, and then click |BS_ASN | MI_ContractCreateReq_Async_Out.
2. In the Configured Receivers section of the Edit Receiver Determination window, click the Add button to add a 

new line.
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3. Click the icon next to the Condition field, to start the Condition Editor.
4. In the Condition Editor window, specify the left operand of the condition as follows:

○ Click the icon next to the Left Operand field to open the Expression Editor.
○ Select the XPath option, and then select the following xpath from the document tree: /cXML/

Header/To/Credential/@domain.
○ This path should be displayed in the XPath Expression field.
○ Click OK to return to the Expression Editor.
○ Select the “=” operator in the Operator column.
○ Select the Right Operand field and enter “SystemID”.

5. Add another condition by clicking on the Insert Expression option. (The Boolean operator between the two 
conditions should be “AND”.)

○ Click the icon next to the Left Operand field to open the Expression Editor.
○ Select the XPath option, and then select the following xpath from the document tree: /cXML/

Header/To/Credential/Identity.
This path should be displayed in the XPath Expression field.

Note
You cannot select a node having child nodes or attributes, directly from the tree. You must first select 
the child node or attribute and edit the xpath expression in the XPath Expression field to remove the 
child element.

○ Click OK to return to the Expression Editor.
○ Select the “=” operator in the Operator column.
○ Select the Right Operand field and specify the Logical System Name corresponding to the Business 

System for which you are doing the configuration. E.g. I60,EC7.
6. Click OK to close the Condition Editor.
7. Click the icon next to the Communication Component field to start the Choose Communication Component 

window, and select the Communication Component corresponding to the Logical System Name you specified 
in the Condition.

Note
For Multi ERP implementation, repeat the steps 2 to 7 for all your SAP ERP instances.

8. Save the Receiver Determination settings.

How to configure interface determination settings for the contract 
integration scenario

Context

Configure the interface determination settings to enable mapping enhancements.

40 P U B L I C

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA

Integrating contract information with SAP ERP



Procedure

1. Expand Interface Determination, and then click | BS_ASN | | BS_SAPR3_50 | ... .
2. In the Receiver Interfaces section of the Edit Interface Determination window, click the operation mapping 

value under the Operation Mapping column, then click the Value List drop down and select Value List.
3. Select the operation mapping IFM_ContractRequest_to_PurchasingContractERPCreateRequest and 

click Apply.
4. The Multiplicity column displays the value "0..unbounded".

5. Save the interface determination settings.

Note
Configuring the Interface Determination is a mandatory step if you need to configure the mappings.

How to activate the contract integration scenario

Procedure

Using the Change List tab on the main application screen, activate all the Change Lists containing the objects 
created and modified during the scenario setup.

Results

The Contracts transaction is now ready for execution.
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Integrating Supplier Information and 
Performance Management with SAP ERP and 
MDG

This chapter contains the following sections:

In this section:

About the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP and 
MDG [page 42]

Configuring the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP 
and MDG [page 50]

Exporting and importing supplier master data [page 54]

Implementing BAdIs to modify structures [page 57]

Checking the status of supplier master data export [page 59]

Viewing vendor ID and business partner mappings [page 60]

Viewing error logs [page 60]

MDG business functions for supplier master data integration [page 61]

About the integration of SAP Ariba Supplier 
Information and Performance Management with SAP 
ERP and MDG
Buyers using SAP Ariba Supplier Information and Performance Management can integrate supplier master data 
between SAP Ariba Supplier Information and Performance Management and SAP ERP. The supplier master data 
integration uses the SAP Business Partner integration services and the interfaces provided by SAP MDG 
Foundation.

SAP MDG Foundation infrastructure is available on SAP ERP 6.0 EhP 6 and later versions only. Users that have 
licensed the MDG application can also leverage additional master data governance features that the MDG 
application provides.

You can use one of the following integration methods to integrate SAP Ariba Supplier Information and 
Performance Management with SAP ERP and MDG:

● Direct Connectivity
● Mediated Connectivity through SAP NetWeaver PI

The SAP Ariba Supplier Information and Performance Management integration with SAP ERP is bidirectional. You 
can export supplier master data from SAP ERP to SAP Ariba Supplier Information and Performance Management 
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(outbound) and import supplier master data from SAP Ariba Supplier Information and Performance Management 
to SAP ERP (inbound).

When you export the supplier data from SAP ERP to SAP Ariba Supplier Information and Performance 
Management for the first time, you can use the full load option. For the outbound full load integration, you can use 
the SAP Data Replication Framework (DRF).

For subsequent outbound integration events, you can use the incremental load option. The incremental load 
updates only those records that were added or modified since the last supplier master data integration event.

To import supplier data from SAP Ariba Supplier Information and Performance Management to SAP ERP, you can 
use the incremental update option. You can import only those supplier records that are marked as "Integrated" in 
SAP Ariba Supplier Information and Performance Management. When the master data import is complete, SAP 
ERP sends a confirmation message to SAP Ariba Supplier Information and Performance Management.

You can use either SAP area menu items or the transaction codes to access transactions for supplier data 
integration. To access the area menu, go to /n/ARBA/SIPM.

The following table lists the area menus and transaction codes that you can use for exporting and importing of 
supplier master data and retrieving the status of master data export:

Table 3: Area menu and transaction codes for supplier master data export and import

Area menu Transaction code Description

DRFOUT Enables you to export the supplier mas­
ter data from SAP ERP to SAP Ariba 
Supplier Information and Performance 
Management in the full load mode.

SAP Menu Integration from SAP 
to SIPM Reports Integrate 
Suppliers to SIPM

/n/ARBA/SIPM_OUT Enables you to export the supplier mas­
ter data from SAP ERP to SAP Ariba 
Supplier Information and Performance 
Management in the incremental load 
mode.

SAP Menu Integration from SIPM 
to SAP Reports Integrate 
Suppliers to SAP

/n/ARBA/SIPM_IN Enables you to import the supplier mas­
ter data from SAP Ariba Supplier Infor­
mation and Performance Management 
to SAP ERP in the incremental load 
mode.

SAP Menu Integration from SAP 
to SIPM Reports Download 
Confirmation from SIPM

/n/ARBA/SIPM_CONF Enables you to retrieve the status of sup­
plier master data export from SAP ERP 
to SAP Ariba Supplier Information and 
Performance Management.

Tip
If you need to download the CSV files locally, you can select the Test Run option that is available for the 
incremental load integration.

If a supplier is deleted in SAP Ariba Supplier Information and Performance Management, the corresponding 
records in SAP ERP are marked as deleted. Similarly, when a supplier is marked as deleted in SAP ERP, the 
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corresponding records are marked as inactive and sent to SAP Ariba Supplier Information and Performance 
Management in the next export. However, blocking of a supplier is supported only in SAP ERP. Though SAP Ariba 
Supplier Information and Performance Management sets a flag to indicate that a supplier is blocked, it does not 
block the supplier from transacting on SAP Ariba Supplier Information and Performance Management.

Note
The SAP ERP integration discussed in this chapter applies to an earlier version of Ariba Supplier Information 
and Performance Management (classic functionality). SAP Ariba Supplier Lifecycle and Performance uses a 
new supplier database, which is different from the supplier databases that SAP Ariba Sourcing, SAP Ariba 
Contracts, and the earlier version of SAP Ariba Supplier Information and Performance Management (classic 
functionality) use. When you configure integration with SAP Ariba Supplier Lifecycle and Performance, the new 
supplier database replaces your existing supplier database.

For information about the SAP ERP integration with SAP Ariba supplier management solutions including SAP 
Ariba Supplier Lifecycle and Performance, new version of SAP Ariba Supplier Information and Performance 
Management (extended functionality), and SAP Ariba Supplier Risk, see the chapter Integrating SAP Ariba 
Supplier Lifecycle and Performance with SAP ERP [page 63].

Enabling this Feature

This feature is disabled by default. To enable this feature, please have your Designated Support Contact log a 
service request. An SAP Ariba Customer Support representative will follow up to complete the request.

For information about how to configure this feature, see Configuring the integration of SAP Ariba Supplier 
Information and Performance Management with SAP ERP and MDG [page 50].

Prerequisites

You must implement the prerequisites in the following order:

1. Ensure that your SAP ERP system is SAP ERP 6.0 EhP 6 and above.
2. Enable the business functions listed in MDG business functions for supplier master data integration [page 

61], set up the Customer Vendor Integration, and assign a target system for replication model or outbound 
implementation. For more information, see the Configuring Master Data Governance for Supplier guide on the 
SAP Help portal.

3. Implement the following SAP notes in the order the notes are listed here:
1. 1750821 (Not required if you are using SAP ERP 6.0 EhP 7.)
2. 1974397
3. 1912305
4. 2211045
5. 2274626
6. 2314124

4. Import the latest SAP Ariba sourcing transports.
5. Activate the /ARBA/SIPM replication model. You can activate /ARBA/SIPM from the DRFIMG transaction. For 

more information, see Activating the replication model [page 52].
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6. Implement implicit enhancement in SAP ERP. For more information, see Configuring implicit enhancement for 
the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP [page 52]

7. Maintain value mappings for region code and language in the /ARBA/VALUE_MAP table. For more information, 
see Configuring the integration of SAP Ariba Supplier Information and Performance Management with SAP 
ERP and MDG [page 50].

8. Ensure that the supplier records in SAP Ariba Supplier Information and Performance Management are marked 
as Supplier Integration Enabled before you import those records to SAP ERP. You can import only those 
records that are marked as Supplier Integration Enabled.

9. (For SAP S/4HANA) To update vendor contact in the table /ARBA/DELTA_CH, maintain the parameter /
ARBA/SIPM_BPROLE_CON in the table /ARBA/TVARV.
Maintain the following values:
○ Variable Name: /ARBA/SIPM_BPROLE_CON
○ Selection cat.: P
○ Number: 0
○ Char20: Blank
○ Char20: Blank
○ INCL/EXCL: I
○ Option: EQ
○ Selection value : BUP001
○ Selection value : Blank

Limitations

● Integration of SAP Ariba Supplier Information and Performance Management with SAP ERP is not supported 
over Ariba Integration Tool Kit.

● Purchase organization, company code, and bank data from SAP ERP are not exported to SAP Ariba Supplier 
Information and Performance Management.

● If a supplier organization does not have any users associated with that, such supplier organizations cannot be 
integrated with SAP ERP.

● Only one address is supported per supplier.
● SAP Ariba Supplier Information and Performance Management sends the full name to SAP ERP. SAP ERP 

splits the full name that is received from SAP Ariba Supplier Information and Performance Management into 
first name and last name. SAP ERP assigns the part before the first space in the name as the first name and 
the rest as the last name. If the first or last name exceeds 35 characters, SAP Ariba Supplier Information and 
Performance Management truncates the name by cutting the characters after the maximum allowed limit of 
35 characters.

● Supplier data integration between SAP ERP and SAP Ariba Supplier Information and Performance 
Management does not occur in real time. Integration events occur at scheduled intervals. Between two 
integration events, the supplier data in SAP ERP and SAP Ariba Supplier Information and Performance 
Management might not be synchronized. You must check the last integration event and ensure that the data is 
synchronized before you trigger a transaction, such as raising a purchase order. For example, a purchase 
order from SAP ERP might contain an outdated address or contact if a supplier record in SAP Ariba Supplier 
Information and Performance Management has been modified after the last integration event.

● Ensure that you do not enter more than ten characters while creating the Login ID for users on the SAP Ariba 
Supplier Information and Performance Management. MDG supports only ten characters in the reference 
fields.
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● The maximum number of characters SAP ERP supports across columns in a row is 4096. If the data you 
integrate exceeds 4096 characters, SAP ERP truncates the data.

Tip
When you integrate supplier data that might extend beyond the 4096-character limit, filter out less 
significant fields to ensure that the data does not exceed the 4096-character limit.

● Vendor roles FLVN00 and FLVN01 are not supported on SAP ERP 6 EHP 8. Ensure that you do not assign 
these vendor roles when you create business partners for SAP Ariba Supplier Information and Performance 
Management integration with SAP ERP 6 EHP 8.

Related Information

Configuring the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP and 
MDG [page 50]
Exporting and importing supplier master data [page 54]
Implementing BAdIs to modify structures [page 57]
Checking the status of supplier master data export [page 59]
Proxies, programs, and structures for supplier master data integration [page 46]

Proxies, programs, and structures for supplier master data 
integration

The following sections list the proxies, programs, and structures that are required for supplier master data 
integration.

Proxies

Use the following proxies to set up direct and mediated connectivity:

● /ARBA/CO_SI_SOURCING_UPLOAD for outbound connections.
● /ARBA/CO_SI_SOURCING_DOWNLOAD for inbound connections.

Programs and classes

The /ARBA/MD_SUPPLIER_SIPM contains the following programs and classes:

● Programs:
○ /ARBA/CR_MD_SUPPLIER_SIPM_IN. To process the inbound incremental updates.
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○ /ARBA/CR_SUPPLIER_SIPM_OUT. To process the outbound incremental updates.
○ /ARBA/CR_SUPPLIER_SIPM_CONF_IN. To process the status checking of outbound updates.

● Classes:
○ /ARBA/CL_MDG_SUPPLIER. For SAP Ariba Supplier Information and Performance Management 

integration with SAP ERP.
○ /ARBA/CL_MDG_BP_REPLICATE_DRF. For outbound integration.
○ /ARBA/CL_MDG_BP_RPLCTRQ. For inbound integration.

Structures

● /ARBA/SUPPLIER_INFO. To maintain the fields for supplier information captured in the Suppliers.CSV file.
● /ARBA/CONTACT_INFO. To maintain the fields for contact or user information captured in the Users.CSV file.
● /ARBA/SIPM_IDNUMBERS. To maintain the fields for success confirmation information captured in the 

SuccessConfirmation.CSV file.
● /ARBA/SIPM_ERROR. To maintain the fields for error messages captured in the Errors.CSV file.

CSV files for SAP Ariba Supplier Information and 
Performance Management integration with SAP ERP

Cloud Integration release 7.0 generates CSV files, which are listed in this section, to transfer supplier data between 
SAP ERP and SAP Ariba Supplier Information and Performance Managementt and to confirm the status of supplier 
master data export and import.

A mapping of fields in SAP ERP and SAP Ariba Supplier Information and Performance Management is maintained 
in the /ARBA/FIELD_MAP table. The /ARBA/FIELD_MAP table contains the following structures under solution 
SIPM:

● /ARBA/SUPPLIER_INFO
● /ARBA/CONTACT_INFO
● /ARBA/SIPM_SUCCESS
● /ARBA/SIPM_ERRORS

Suppliers.CSV

The Suppliers.CSV file contains the following fields:

● VendorID
● SystemID
● MDG ID
● NetworkID
● DUNS
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● CustomDomainName
● CustomDomainValue
● Active
● Blocked
● Blocked Reason
● Name1
● Name2
● Name3
● Name4
● AddressID
● Street
● City
● Country
● State
● PostalCode
● Language
● CorporateEmailAddress
● CorporateFax
● CorporatePhone
● CorporateURL
● Legal Name
● State of Incorporation
● Global Location Number
● Tax ID
● State Tax ID
● Regional Tax ID
● VAT ID

Users.CSV

The Users.CSV file contains the following fields:

● CSV Column
● VendorID
● SystemID
● MDGID
● Active
● Name
● IsEmailInviteNeeded
● IsUserApproved
● Email Address
● Phone Number
● Fax
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SuccessConfirmation.CSV

The SuccessConfirmation.CSV file contains the following fields:

● VendorID
● SystemID
● MDGID
● LoginID

Errors.CSV

The Errors.CSV file contains the following fields:

● LoginID
● MDGID
● MessageId
● MessageNum
● MessageText
● MessageType
● SystemID
● VendorID

Related Information

Configuring the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP and 
MDG [page 50]

Maintaining supplier user login ID information on SAP ERP

You can maintain contact information for suppliers on the SAP ERP system. SAP Ariba sends this contact 
information as “supplier users” to SAP Ariba Supplier Information and Performance Management. Users in SAP 
Ariba Supplier Information and Performance Management must have a unique login ID to log in to SAP Ariba 
Supplier Information and Performance Management. You can choose to maintain unique login ID for users. To do 
so, maintain the Login ID for users in the /ARBA/USERID table. SAP Ariba uses this Login ID while importing and 
exporting the supplier information for users. When you do not maintain the Login ID for users in the /ARBA/
USERID table, SAP Ariba uses the Business Partner/MDG ID as the Login ID while sending the supplier information 
to SAP Ariba Supplier Information and Performance Management. When SAP Ariba Supplier Information and 
Performance Management sends the supplier information to SAP ERP, SAP Ariba updates the Login ID that is 
being sent from SAP Ariba Supplier Information and Performance Management in the/ARBA/USERID table on the 
SAP ERP system.
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Related Information

Maintaining supplier user login IDs on SAP ERP [page 53]

Configuring the integration of SAP Ariba Supplier 
Information and Performance Management with SAP 
ERP and MDG

Context

Follow these steps to configure the integration of SAP Ariba Supplier Information and Performance Management 
with SAP ERP and Master Data Governance (MDG). Ensure that you have the necessary prerequisites.

Procedure

1. Set up one of the following connectivity models between SAP ERP and SAP Ariba Supplier Information and 
Performance Management:

○ Direct Connectivity. To set up direct connectivity, use the SOAMANAGER transaction. For more information 
see the Configuring direct connectivity [page 99] section.

○ Mediated Connectivity. For more information, see Configuring mediated connectivity [page 106].

Note
The proxy names for SAP Ariba Supplier Information and Performance Management integration are /
ARBA/CO_SI_SOURCING_UPLOAD and /ARBA/CO_SI_SOURCING_DOWNLOAD. You need to configure logical 
ports for these proxies.

2. Note
To access the SIPM area menu, go to /n/ARBA/SIPM.

From the SIPM area menu, go to SAP Menu Configuration Parameter Direct Connectivity 
Parameters  and configure the following parameters in the /ARBA/AUTH_PARAM table:

○ Solution. The SAP Ariba application that you want to integrate the master data with. For example, SIPM.
○ Realm. The name of your company as configured in the SAP Ariba application. For example, s4All.
○ Wait. Number of minutes to wait before SAP ERP attempts to reconnect with the SAP Ariba application. 

For example, 02.

3. From the SIPM area menu, go to SAP Menu Configuration Parameter Define Parameters  and 
maintain the following variables in the /ARBA/TVARV table:
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○ /ARBA/SIPM_IN_TEST. The location to which you want to save the inbound files when you use the Test 
Run option.

○ /ARBA/SIPM_IN_DC. The location to which you want to save the inbound files when you use direct or 
mediated connectivity.

○ /ARBA/SIPM_BPROLE. The value of the BPROLE that you have configured to connect SAP Ariba Supplier 
Information and Performance Management and MDG.

○ /ARBA/SIPM_ACCGRP. The account group that you have maintained for the BPROLE. Specify an 
internally-generated number for account group.

○ /ARBA/SIPM_OUT_TEST. The location to which you want to save the outbound files when you use the 
Test Run option in the Incremental mode.

○ /ARBA/SIPM_OUT_DC. The location to which you want to save the outbound files when you use direct or 
mediated connectivity.

4. Go to SAP Menu Configuration Parameter Define SAP to Sourcing (SIPM) Field  and maintain the 
mappings for solution SIPM in the /ARBA/FIELD_MAP table.

This table contains the field mapping between SAP ERP and SAP Ariba Supplier Information and Performance 
Management under solution SIPM.

If you want to customize any of the fields, you must make the necessary changes to the corresponding entries 
in this table.

If you want to add new fields, add an entry under the corresponding structure.
5. (Required only for Full Load) Set the PacketSize parameter. The number of records that SAP ERP imports at 

a time depends on the value configured for the PacketSize parameter in MDG. If PacketSize is set to 1000, 
only 1000 records are exported or imported in one batch. For more information about setting the PacketSize 
parameter, see Configuring Master Data Governance for Supplier.

6. From the SIPM area menu, go to SAP Menu Configuration Parameter Define Value Mapping  and 
maintain the mappings for region code and language in the /ARBA/VALUE_MAP table.

SAP Ariba Supplier Information and Performance Management uses expanded forms for province names and 
languages, whereas SAP ERP uses custom codes. You need to maintain a mapping between the names in SAP 
Ariba Supplier Information and Performance Management and the corresponding values in SAP ERP. A typical 
entry in /ARBA/VALUE_MAP contains the following values:

○ Integration Field
○ Internal Value (SAP)
○ External Value (Ariba)
○ Country

Note
While specifying the Region in the /ARBA/VALUE_MAP table on your SAP ERP, ensure that the case you 
maintain for the region is the same case you maintain on the SAP Ariba Supplier Information and 
Performance Management system to avoid errors during import and export of supplier data.

7. Configure implicit enhancements in SAP ERP. For more information see Configuring implicit enhancement for 
the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP [page 52].

8. (Optional) If you want to maintain unique login IDs for users, you must ensure that you maintain the Login ID 
for each user in the /ARBA/USERID table before you import supplier master data from SAP Ariba Supplier 
Information and Performance Management to SAP ERP.
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Activating the replication model

Context

When you install the transports, the /ARBA/SIPM replication model is imported to SAP ERP. However, you must 
activate the replication model /ARBA/SIPM before you can use it for any configuration.

Procedure

1. Go to transaction code DRFIMG.

The Display IMG screen appears.
2. Expand Define Custom Settings for Data Replication and click Define Replication Models.

The Change View "Define Replication Model" : Overview screen appears.
3. From the Define Replication Model table in the right panel, select /ARBA/SIPM.

4. Click Activate.

The Active check box that corresponds to the replication mode /ARBA/SIPM is selected.

Configuring implicit enhancement for the integration of 
SAP Ariba Supplier Information and Performance 
Management with SAP ERP

Context

To enable the integration between SAP Ariba Supplier Information and Performance Management and SAP ERP, 
you must configure an implicit enhancement in SAP ERP.

Procedure

1. In your SAP ERP system, navigate to transaction code SE37 - MDG_BS_BP_OUTBOUND_DRF and click 
Display.

2. Click Enhance in the application toolbar.
3. Click Edit > Enhancement Operations > Show Implicit Enhancement Options to display a line after the 

FUNCTION mdg_bs_bp_outbound_drf form.

4. Right-click the line and select Enhancement Implementation > Create.
5. Click Code on the Choose Type of Enhancement popup to display Select or Create Enhancement 

Implementation.
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6. Click Create Enhancement Implementation.
7. Enter a name and description for the enhancement and press Enter.
8. In the package popup, specify your Z or Y package, press Enter, and save the package to a transport request.
9. Copy the following code:

 DATA :              go_proxy TYPE REF TO /arba/cl_mdg_supplier.
           CREATE OBJECT go_proxy.
           CALL METHOD go_proxy->UPDATE_DELTA_TABLE
           EXPORTING            ET_LS_BP = ct_bp.

10. Paste the copied code into the Enhancement Implementation.
11. Activate the enhancement and save it.

Defining the business system for SAP Ariba Supplier 
Information and Performance Management

Procedure

1. Select Business System from the main SLD page to open the Business System page.
2. Click New Business System here to open the Business System Wizard.
3. In the Wizard, select Third-Party as the technical system type to associate the business system with, and then 

click Next.
4. Select the technical system, for example, TS_ASN, created from the System field, and then click Next.

Note
The Logical System Name is not required.

5. Enter the business system name, ARIBA_SIPM, in the Name field, and click Next.

6. Specify the installed products. Make sure that the product ASN, NW04.1 and the related component 
ARIBA_SUPPLIER_CONN_ADAPTER, CIX of ariba.com, installed on the technical system, are selected, 
and then click Next.

7. Click Finish.

Maintaining supplier user login IDs on SAP ERP

Context

You can choose to maintain unique login ID for users. To do so, maintain the Login ID for users in the /ARBA/
USERID table.
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Procedure

1. Run the transaction code SM30.

2. Choose table view /ARBA/USERID.

3. Click New Entries. The New Entries: Overview of Added Entries page appears.
4. Enter the Business Partner/MDG ID of the contact person in the SAP MDG ID column.
5. Enter a corresponding Login ID in the Ariba Userid column. Add an entry for each user.
6. Save the changes.

Exporting and importing supplier master data
After you set up connectivity between SAP ERP and SAP Ariba Supplier Information and Performance 
Management, you can export or import supplier master data. Always check the status of the export event before 
you initiate an import event.

Note
To be able to integrate supplier and user data with SAP Ariba Supplier Information and Performance 
Management, the data that you export must contain the following information:

● Email address and telephone number for users.
● Telephone number for suppliers.

The following sections contains instructions for exporting and importing supplier master data:

Related Information

About the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP and MDG 
[page 42]
Configuring the integration of SAP Ariba Supplier Information and Performance Management with SAP ERP and 
MDG [page 50]
Checking the status of supplier master data export [page 59]

Exporting supplier master data in the full load mode

Prerequisites

Ensure that you have configured the integration of SAP Ariba Supplier Information and Performance Management 
with SAP ERP.
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Context

You can use the full load option when you export the supplier data from SAP ERP to SAP Ariba Supplier 
Information and Performance Management for the first time.

Procedure

1. Run the transaction code DRFOUT.

The Execute Data Replication screen appears.
2. Specify Replication Model as /ARBA/SIPM.

3. Specify Outbound Implementation as /ARBA/SIPM.

4. In Replication Mode, select Manual.
5. To specify filters based on which you want to export supplier master data, click Manual Replication Filter 

Criteria.

The Manual Replication Filter Criteria screen appears.
6. In the Manual Replication Filter Criteria screen, specify the filtering criteria based on which you want to 

export supplier master data.

For example, to export only master data that map to vendor numbers 5000 to 6000, click Vendor from the 
left-side pane and enter 5000 to 6000 in the range fields that correspond to the Vendor entry in the right-side 
pane.

7. Save the filter criteria.

The Execute Data Replication page appears.
8. Click the Execute button.

The supplier master data execution begins.

Exporting supplier master data in the incremental load 
mode

Prerequisites

Ensure that you have configured the integration of SAP Ariba Supplier Information and Performance Management 
with SAP ERP.

Context

You can use the incremental load option to export supplier master data from SAP ERP to SAP Ariba Supplier 
Information and Performance Management. The incremental load option updates only those records that have 
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been updated since the last supplier master data integration event. You can schedule this event to run at regular 
intervals.

Procedure

1. Go to transaction code /n/ARBA/SIPM_OUT.

The Program for Incremental Load - SAP Outbound screen appears.
2. Select one of the following options:

○ Test Run. Select this option to download the CSV files to a local storage. If you select this option, the CSV 
files are downloaded to the location specified for /ARBA/SIPM_OUT_TEST in the /ARBA/TVARV table.

○ Upload from SAP to SIPM. Select this option to import the supplier master data from SAP ERP to SAP 
Ariba Supplier Information and Performance Management. If you select this option, the CSV files are 
downloaded to the location specified for /ARBA/SIPM_OUT_DC in the /ARBA/TVARV table.

3. Click the Execute button.

Supplier master data import from SAP ERP to SAP Ariba Supplier Information and Performance Management 
begins.

Importing supplier master data

Prerequisites

● Ensure that you have configured the integration of SAP Ariba Supplier Information and Performance 
Management with SAP ERP.

● You must mark the supplier records as integrated before you can import those records from SAP Ariba 
Supplier Information and Performance Management to SAP ERP.

Tip
Before you import supplier master data from SAP Ariba Supplier Information and Performance 
Management to SAP ERP for the first time, mark all the supplier records in SAP Ariba Supplier Information 
and Performance Management as integrated.

Context

You can import supplier master data from SAP Ariba Supplier Information and Performance Management to SAP 
ERP. Only the incremental load mode is supported for the import of supplier master data. You can schedule this 
transaction to run at regular intervals.
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Procedure

1. Run the transaction code /n/ARBA/SIPM_IN.

The Program for Incremental Load - SAP Inbound page appears.
2. Select one of the following options:

○ Test Run. Select this option to download the CSV files to a local storage. If you select this option, the CSV 
files are downloaded to the location specified for /ARBA/SIPM_IN_TEST in the /ARBA/TVARV table.

○ Download from SIPM. Select this option to import the supplier master data from SAP Ariba Supplier 
Information and Performance Management to SAP ERP. If you select this option, the CSV files are 
downloaded to the location specified for /ARBA/SIPM_IN_DC in the /ARBA/TVARV table.

3. Click the Execute icon.

Supplier master data import from SAP Ariba Supplier Information and Performance Management to SAP ERP 
begins.

Implementing BAdIs to modify structures
The BAdIs /ARBA/SUPPLIER_SIPM_IN and /ARBA/SIPM_OUTBOUND enable you to modify the structures and to 
map additional supplier information.

● To enhance the Supplier.CSV and Contacts.CSV structures, implement /ARBA/SIPM_OUTBOUND.
○ You can use the following code to modify the Supplier.CSV structure:

** Enhancement to change Suppliers.CSV structure         GET BADI go_badi_out.
        IF go_badi_out IS BOUND.
          CALL BADI go_badi_out->create_supplier_csv
            EXPORTING
              et_bupa_msg = lt_proxy_data
            CHANGING
              et_csv_out  = gt_csv_out.
        ENDIF. 

○ You can use the following code to modify the Contact_Info (for Users.CSV) structure:

** Enhancement to change contacts.csv structure   GET BADI lo_badi_out.
  IF lo_badi_out IS BOUND.
    CALL BADI lo_badi_out->create_contacts_csv
      EXPORTING
        et_csv_out         = lt_csv_out
        et_relshp_msg      = et_relshp_msg
      CHANGING
        et_csv_out_contact = lt_con_out.
  ENDIF. 
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Note
To map contact person workplace address information in SAP S/4HANA 1610, add the following code in the 
method CREATE_CONTACTS_CSV of the BAdI /ARBA/SUPPLIER_SIPM_OUT:

data : lw_csv_contact type /ARBA/CONTACT_INFO,           lw_but051 type BUT051.
    loop at et_csv_out_contact into lw_csv_contact.
 CALL FUNCTION 'CONVERSION_EXIT_ALPHA_INPUT'
      EXPORTING
        input  = lw_csv_contact-mdgid
      IMPORTING
        output = lw_csv_contact-mdgid.
      select single * from BUT051 into lw_but051 where PARTNER2 = 
lw_csv_contact-mdgid.
        lw_csv_contact-phone = lw_but051-TEL_NUMBER .
        lw_csv_contact-fax = lw_but051-FAX_NUMBER.
        lw_csv_contact-email = lw_but051-SMTP_ADDRESS.
        modify et_csv_out_contact from lw_csv_contact index sy-tabix.
    ENDLOOP. 

● To modify the error and ID number structures and to map additional suppliers, implement /ARBA/
SUPPLIER_SIPM_IN.
○ You can use the following code to modify the error and ID number structures:

*Enhancement to change error and id number structures.     GET BADI go_badi.
    IF go_badi IS BOUND.
      CALL BADI go_badi->call_proxy_in
        EXPORTING
          it_vendor    = gt_vendor
          it_contact   = gt_contact
        CHANGING
          et_error     = gt_error
          et_idnumbers = gt_idnumbers.
    ENDIF. 

○ You can use the following code to map additional contact information:

       *Enhancement to map additional contact information     IF go_badi IS BOUND.
      CALL BADI go_badi->map_contactpersons_to_proxy
        EXPORTING
          it_contact                     = it_contact
          it_vendor                      = it_vendor
        CHANGING
          ct_business_partner_suiterepli = lt_business_partner_suiterepli.
    ENDIF. 

○ You can use the following code to map additional supplier information:

*Enhancement to map additional supplier information     IF go_badi IS BOUND.
      CALL BADI go_badi->map_vendors_to_proxy
        EXPORTING
          iw_vendor                      = gw_vendor
        CHANGING
          cw_business_partner_suiterepli = gw_business_partner_suiterepli.
    ENDIF. 
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Checking the status of supplier master data export
Prerequisites

Ensure that you have configured the integration of SAP Ariba Supplier Information and Performance Management 
with SAP ERP.

Context

You can retrieve the status of supplier master data export from SAP ERP to SAP Ariba Supplier Information and 
Performance Management. You can schedule this transaction to run at regular intervals between supplier master 
data export events.

Procedure

1. Run the transaction code /n/ARBA/SIPM_CONF.

The SIPM Outbound Confirmation page appears.
2. Select one of the following options:

○ Test Run. Select this option to download the CSV files that contain the export status to a local storage. If 
you select this option, the CSV files are downloaded to the location specified for /ARBA/SIPM_OUT_TEST 
in the /ARBA/TVARV table.

○ Call Confirmation In. Select this option to import the CSV files that contain the export status to SAP ERP. 
If you select this option, the CSV files are downloaded to the location specified for /ARBA/SIPM_OUT_DC 
in the /ARBA/TVARV table.

3. Click the Execute button.

Related Information

Viewing error logs [page 60]
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Viewing vendor ID and business partner mappings

Context

After getting the success confirmation from the SAP ERP and SAP Ariba Supplier Information and Performance 
Management, customers can view the mapping for the vendor ID and business partner using the transaction Code 
MDG_ANALYSE_IDM.

Procedure

1. Go to TCode MDG_ANALYSE_IDM.

2. Choose Business Partner in the Bus. Obj. Type field.
3. Choose 888 in the Object ID Type field.
4. Enter the System ID In the ID Value field.

Note
Enter the System ID that you have for the vendor on the SAP Ariba Supplier Information and Performance 
Management.

5. View the mapping for the vendor ID and business partner.

Viewing error logs

Context

You can view the application errors that might occur during the integration of SAP Ariba Supplier Information and 
Performance Management with SAP ERP from the SAP ERP application log.

Procedure

1. Run the transaction code SLG1.

The Analyse Application Log screen appears.
2. In the Object field, enter /ARIBA/SIPM.

3. In the Subobject field, enter /ARIBA/SUB_SIPM.

4. Specify the filters.
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5. Click Execute.

The Display Logs screen lists the logs associated with the SAP Ariba Supplier Information and Performance 
Management integration with SAP ERP.

MDG business functions for supplier master data 
integration
Before you set the master data integration between SAP Ariba Supplier Information and Performance 
Management and SAP ERP, you must activate the following business functions:

Note
For instructions to activate business functions, see the Configuring Master Data Governance for Supplier guide 
on the SAP Help portal.

SAP ERP 6.0 EhP 6 and EhP 7 with MDG license

Activate the following business functions:

● MDG_FOUNDATION
● CA_BP_SOA
● CA_SUPPLIER_SOA

SAP ERP 6.0 EhP 6 and EhP 7 without MDG license

● Create a custom business function to activate the following switches:
○ MDG_BS_CA_MDGAF_UI_SFWS_06
○ MDG_BS_CA_UI_SFWS_06
○ MDG_DATALOAD_SFWS_01
○ MDG_DRF_MAIN_05
○ MDG_DRF_MAIN_UI_05
○ MDG_DRF_SFWS_06
○ MDG_DRF_UI_SFWS_06
○ MDG_KEY_MAPPING_05
○ MDG_KEY_MAPPING_UI_05
○ MDG_VALUE_MAPPING_05
○ MDG_VALUE_MAPPING_UI_05

● Activate the following business functions:
○ CA_BP_SOA
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○ CA_SUPPLIER_SOA
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Integrating SAP Ariba Supplier Lifecycle and 
Performance with SAP ERP

This chapter contains the following topics:

In this section:

About SAP Ariba Supplier Lifecycle and Performance integration with SAP ERP and Master Data Governance 
[page 63]

Integration workflow [page 65]

MDG business functions for SAP Ariba Supplier Lifecycle and Performance integration [page 66]

How to define a replication model for supplier data integration [page 67]

Installing and configuring SAP Ariba Supplier Lifecycle and Performance integration with SAP ERP [page 68]

Customizing supplier master data integration [page 83]

How to set up supplier data synchronization [page 87]

How to replicate Business Partner master data from SAP Ariba Supplier Lifecycle and Performance [page 
88]

How to monitor errors in SAP ERP [page 89]

About SAP Ariba Supplier Lifecycle and Performance 
integration with SAP ERP and Master Data 
Governance

Buyers using SAP Ariba Supplier Lifecycle and Performance can now integrate Business Partner master data 
between SAP Ariba Supplier Lifecycle and Performance and SAP ERP and Master Data Governance (MDG).

The integration between SAP Ariba Supplier Lifecycle and Performance and SAP ERP and MDG is bidirectional and 
enables you to replicate vendor master data as business partners in SAP ERP and SAP Ariba Supplier Lifecycle 
and Performance application.

The outbound integration from SAP ERP to SAP Ariba Supplier Lifecycle and Performance is achieved through 
business partner interfaces provided by MDG and standard SAP programs such as Data Replication Framework 
(DRF) programs. You can use the DRFOUT transaction code for initial replication of business partners from SAP 
ERP to SAP Ariba Supplier Lifecycle and Performance.

The inbound integration from SAP Ariba Supplier Lifecycle and Performance to SAP ERP and MDG is achieved 
through a polling client, /ARBA/SM_BUSINESS_PARTNER_PULL, that runs on SAP ERP. You can specify the polling 
frequency and configure the polling client to poll SAP Ariba Supplier Lifecycle and Performance at regular intervals 
for business partner master data or confirmation messages for the business partners exported from SAP ERP.
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Alternatively, you can manually trigger the poll by executing the /ARBA/SM_BUSINESS_PARTNER_PULL program 
from the SAP ERP user interface. When you execute this program, you can choose one or more of the following 
options:

● Business Partner Bulk Replicate Request
● Business Partner Bulk Replicate Confirmation
● Business Partner Relationship Bulk Replicate Request
● Business Partner Relationship Bulk Replicate Confirmation

Note
SAP Ariba Supplier Lifecycle and Performance does not currently support Business Partner 
Relationship Bulk Replicate Request and Business Partner Relationship Bulk 
Replicate Confirmation.

Tip
Create a scheduled job to run the polling client and data replication at regular intervals. You can use the 
sm36 transaction code to schedule the program to run at regular intervals.

For every successful poll, SAP Ariba Supplier Lifecycle and Performance 2.0 includes the sequence number of the 
message in the response. The polling client updates the sequence number in the /ARBA/SM_SEQNUM table when a 
poll is successfully completed. In case of an error, an error log is created in SLG1. For subsequent polls, the polling 
client includes the sequence number of the last successful poll, which is stored in /ARBA/SM_SEQNUM.

When a polling request goes without a sequence number, SAP Ariba Supplier Lifecycle and Performance identifies 
it as a first time request and sends the business partner records starting from the first record. The number of 
records that SAP Ariba Supplier Lifecycle and Performance sends in response to a poll request depends on the 
configuration in the SAP Ariba Supplier Lifecycle and Performance application for the maximum number of 
records to include in a response. Currently, this is set to 10 records.

If there are more than the configured number of records to replicate, SAP Ariba Supplier Lifecycle and 
Performance sends the remaining records as responses to subsequent polls until there are no new records to 
replicate. SAP ERP continues to use the same sequence number in the polls until SAP Ariba Supplier Lifecycle and 
Performance sends a new record and updates the sequence number.

SAP ERP and MDG integration with SAP Ariba Supplier Lifecycle and Performance 2.0 uses SOAP messages for 
requesting and receiving data from SAP Ariba Supplier Lifecycle and Performance. SAP Ariba Supplier Lifecycle 
and Performance uses MDG business partner interface structure to store supplier master data. However, SAP 
Ariba Supplier Lifecycle and Performance integration with SAP ERP supports extension of the business partner 
data structure to enable you to use custom fields to address your specific requirements. For more information 
about extensions and customizations, see Customizing supplier master data integration [page 83].

You can use the Direct Connectivity or Mediated Connectivity integration method to integrate SAP Ariba Supplier 
Lifecycle and Performance with SAP ERP.

Note
SAP Ariba Supplier Lifecycle and Performance uses a new supplier database, which is different from the 
supplier databases that SAP Ariba Sourcing, SAP Ariba Contracts, and the previous version of SAP Ariba 
Supplier Information and Performance Management (classic functionality) use. When you configure integration 
with SAP Ariba Supplier Lifecycle and Performance, the new supplier database replaces your existing supplier 
database. The SAP ERP integration discussed in this chapter applies to SAP Ariba supplier management 
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solutions including SAP Ariba Supplier Lifecycle and Performance, new version of SAP Ariba Supplier 
Information and Performance Management (extended functionality), and SAP Ariba Supplier Risk.

,

Prerequisites

● Ensure that your system meets the following minimum software requirements:
○ SAP ERP 6.0 EHP6 SP1
○ SAP Business Services Foundation 731

● Install the latest SAP Ariba Supplier Lifecycle and Performance transports. If you want to implement this 
feature over the Mediated Connectivity integration method, import the latest TPZ files. For more information, 
see How to import the Ariba components [page 68].

Enabling this feature

This feature is enabled for all customers. For more information on installing and configuring this feature, see 
Integration workflow [page 65].

Integration workflow
The following high-level steps describe the workflow for setting up integration between SAP Ariba Supplier 
Lifecycle and Performance and SAP ERP:

1. If you have not done so already, configure MDG or DRF integration for suppliers. For more information, see the 
Configuring Master Data Governance for Suppliers or XX on the SAP Help portal. For outbound integration, 
complete the following tasks:
○ Enable the business functions listed in the topic MDG business functions for SAP Ariba Supplier Lifecycle 

and Performance integration [page 66].
○ Set up the Customer-Vendor integration, define a replication model [page 67] and assign a target 

system or replication model or outbound implementation.
(SAP ERP)

2. Import the latest SAP Ariba Supplier Lifecycle and Performance transports into SAP ERP [page 68].
(SAP ERP)

3. Maintain table entries for SAP Ariba Supplier Lifecycle and Performance in the /ARBA/SM_SEQNUM table 
[page 69]
(SAP ERP)

4. Set up the SAP ERP system credentials in SAP Ariba Supplier Lifecycle and Performance [page 82].
(SAP Ariba Supplier Lifecycle and Performance)

5. Configure Direct Connectivity [page 70] or Mediated Connectivity [page 74] integration method.
(SAP ERP)
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6. Replicate Business Partner master data from SAP Ariba Supplier Lifecycle and Performance [page 88].
(SAP ERP)

7. Set any default values for supplier fields that you want to send to SAP ERP during supplier synchronization . At 
minimum, you must set vendor.vendorInfoExt.categoryCode to 2 so that SAP ERP recognizes the data 
sent from SAP Ariba Supplier Lifecycle and Performance as supplier data. You must also set default values for 
any required fields that aren't included in, and mapped from, required questions on forms and questionnaires, 
so that those fields will include data during initial synchronization. For more information, see theSAP Ariba 
Supplier Lifecycle and Performance documentation.
(SAP Ariba Supplier Lifecycle and Performance)

8. Specify how and when suppliers created in SAP Ariba Supplier Lifecycle and Performance [page 87] are first 
synchronized to SAP ERP.

MDG business functions for SAP Ariba Supplier 
Lifecycle and Performance integration

For the outbound integration between SAP ERP and SAP Ariba Supplier Lifecycle and Performance, you must 
activate the following business functions:

Note
You do not require MDG license to activate these business functions.

● CA_BP_SOA
● CA_SUPPLIER_SOA
● DRF_FOUNDATION

Note
DRF_FOUNDATION is activated only in SAP_BS_FOUNDATION 748 and later. If you are running a lower 
version of SAP_BS_FOUNDATION, you can use the transaction code SFW2 to define a custom business 
function named Z_DRF_FOUNDATION with the following switches:
○ MDG_BS_CA_MDGAF_UI_SFWS_06
○ MDG_BS_CA_UI_SFWS_06
○ MDG_DATALOAD_SFWS_01
○ MDG_DRF_MAIN_05
○ MDG_DRF_MAIN_UI_05
○ MDG_DRF_SFWS_06
○ MDG_DRF_SFWS_07
○ MDG_DRF_UI_SFWS_06
○ MDG_KEY_MAPPING_05
○ MDG_KEY_MAPPING_UI_05
○ MDG_VALUE_MAPPING_05
○ MDG_VALUE_MAPPING_UI_05
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Note
MDG_DRF_SFWS_07 is not included in versions lower than SAP ERP 6.0 EHP7 and is optional. If you have SAP 
ERP 6.0 EHP6, the switch is not installed and you can ignore it.

If you have an MDG license and have the CA_BP_SOA, CA_SUPPLIER_SOA, and MDG_FOUNDATION business 
functions activated, ensure that you also define and activate the DRF_FOUNDATION business function, which 
contains the following additional switches that MDG_FOUNDATION does not contain:

● MDG_BS_CA_MDGAF_UI_SFWS_06
● MDG_BS_CA_UI_SFWS_06
● MDG_DRF_SFWS_06
● MDG_DRF_SFWS_07
● MDG_DRF_UI_SFWS_06

How to define a replication model for supplier data 
integration
Context

For the outbound integration between SAP ERP and SAP Ariba supplier management solutions to work, you must 
configure the data replication settings.

Procedure

1. Run the transaction code DRFIMG from the SAP ERP user interface.
The Display IMG window appears.

2. Click Data Replication Define Custom Settings for Data Replication Define Technical Settings
Define Technical Settings for Business Systems .
The Change View "Define Business Systems": Overview window appears.

3. To define a new business system and to maintain the logical system for the receiving systems, click New 
Entries.

4. In the New Entries: Overview of Added Entries window, specify a business system, for example ABC_123, 
and a logical system, ABCCLIENT123.

5. Click Save and go back to the Display IMG window.

6. To define a replication model, click Data Replication Define Custom Settings for Data Replication
Define Replication Models .
The Change View "Define Replication Model": Overview window appears.

7. Click New Entries to enter a name for the replication model and add a description.
8. Select the line that contains the newly-added replication model and click Assign Outbound Implementation. 

Create a new entry and enter the following values using the input help:
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○ Outbound Implementation: 986_3 Outbound Impl. for BP/REL via Services
○ Communication Channel: Replication via Services
○ Filter time: Filter After Change Analysis

9. Mark the line and choose Assign Target Systems for Repl. Model /Outb.Impl. Create a new entry and enter 
the business system name for the receiving system that you created.

10. Click Assign Outbound Parameter. Create a new entry, enter the following values, and save.

○ Outb. Parameter: PACK_SIZE_BULK
○ Outb. Parameter value: For example, 100

11. Go back to the Define Replication Model view. Optionally, you can also add an expiration time for the log.
12. Save the replication model.
13. Select the newly-created replication model, and click Activate.

For more information, click the IMG activity documentation icon on the left side of Data Replication
Define Custom Settings for Data Replication Define Replication Models  in the Display IMG window.

Installing and configuring SAP Ariba Supplier 
Lifecycle and Performance integration with SAP ERP
This section contains the following topics:

In this section:

How to import the Ariba components [page 68]

How to maintain table entries [page 69]

Configuring integration methods [page 70]

How to set up SAP ERP credentials in SAP Ariba [page 82]

How to import the Ariba components

Context

You must download the latest version of the SAP Ariba Supplier Lifecycle and Performance transports to 
implement the integration between SAP Ariba Supplier Lifecycle and Performance and SAP ERP. To implement 
Mediated Connectivity, you must download the latest .TPZ files.
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Procedure

1. Go to https://support.ariba.com/Connect/Log_In and log in using your user ID and password. If you do not 
have a User ID and Password for SAP Ariba Connect, contact your SAP Ariba account executive.

2. On the Home page, click Product Information and Documentation.
3. Click Cloud Integration in the Product Information section and then click Resources.

The Cloud Integration Resources page appears.
4. Click the Integration tools for Ariba Supplier Management link.
5. On the Resources tab, click ABAP Transports for SAP ERP. If the list does not contain this entry, contact your 

SAP Ariba account executive.

The Sourcing SAP Transports page appears.
6. Click Download and save the Ariba_Supplier_Management_V_CI_x.zip package.

7. Extract the contents of the ZIP file and import the transports to SAP ERP.
8. If you want to implement the feature over Mediated Connectivity, go back to the Integration Tools for Ariba 

Supplier Lifecycle and Performance page and click SAP NetWeaver PI Mapping from the Resources tab.
The Ariba Supplier Lifecycle and Performance SAP NetWeaver PI Mapping page appears.

9. Click Download and save the Ariba_Supplier _Management_SAP_Netweaver_Repositor_CIx.zip 
package.

10. Extract and import the relevant TPZ files into the SAP Process Integration.

How to maintain table entries

You can use the sm30 transaction code to access tables. To maintain a table, enter the name of the table in the 
Table/View field of the Maintain Table Views: Initial Screen, and click Maintain.

For the SAP ERP integration with SAP Ariba Supplier Lifecycle and Performance 2.0 to work, you must maintain 
the following entries in the /ARBA/SM_SEQNUM table:

Parameter Description Example/Value

Service Name Name of the Supplier Management im­
port service.

BP_REPLICATE_CONFIRM

BP_REPLICATE_REQUEST

BP_RELATNSHP_CONFIRM

BP_RELATNSHP_REQUEST

Note
SAP Ariba Supplier Lifecycle and Per­
formance currently does not support 
BP_RELATNSHP_CONFIRM and 
BP_RELATNSHP_REQUEST serv­
ices.
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Parameter Description Example/Value

Logical Port The logical port that you configure in 
SOAMANAGER.

Note
If you are using Mediated Connectiv­
ity integration method, leave this pa­
rameter blank.

For example, Polling_Client

Note
If you are using Mediated Connectiv­
ity integration method, leave this pa­
rameter blank.

Sequence Number The sequence number for the last suc­
cessful import for the given service.

You can leave this blank. When this pa­
rameter is left blank, SAP Ariba Supplier 
Lifecycle and Performance identifies the 
request as a first time request and sends 
records starting with the first record to 
the maximum number of records as con­
figured to send in one batch.

The sequence number received from 
SAP Ariba Supplier Lifecycle and Per­
formance replaces the value for this pa­
rameter and is included in the next re­
quest.

If the request contains a sequence num­
ber, SAP Ariba Supplier Manage­
mentsends the records since the last re­
cord as indicated by the sequence num­
ber.

Configuring integration methods

This section contains the following topics:

In this section:

How to configure direct connectivity [page 70]

How to configure mediated connectivity [page 74]

How to configure direct connectivity

You can configure direct connectivity between SAP ERP and SAP Ariba Supplier Management 2.0. You can use the 
SOAMANAGER [page 71] transaction to configure direct connectivity.

70 P U B L I C

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA

Integrating SAP Ariba Supplier Lifecycle and Performance with SAP ERP



Prerequisites

● Install the latest SAP Ariba Sourcing transports. For more information, see How to import the Ariba 
components [page 68].

● Maintain the entries in the /ARBA/SM_SEQNUM table. For more information, see How to maintain table entries 
[page 69].

● Specify the system ID of SAP ERP and the shared secret password as explained in How to set up SAP ERP 
credentials in SAP Ariba [page 82].

Note
Only the password is required for shared secret based authentication for SAP Ariba Supplier Management 
integration with SAP ERP.

● Configure the Web Service Runtime for SAP ERP on Client 000 and the actual business system client. For 
more information, see Configuring the Web Service Runtime on the SAP Help portal.

How to configure SOAMANAGER

Context

You can use the SOAMANAGER configuration to set up Direct Connectivity for integrating SAP Ariba supplier 
management solutions with SAP ERP. This topic explains the SOAMANAGER configuration for the polling client.

To set up SOAMANAGER configuration for the outbound services, repeat these steps with the proxy name and URL 
access path that correspond to the DRFOUT and confirmation out services.

Procedure

1. Go to transaction code SOAMANAGER.
2. In the Service Administration tab, click Web Service Configuration.
3. Specify the following Search Criteria:

○ In the Search By pull-down list, select Consumer Proxy.
○ Select Contains from the options.
○ Enter the first few characters of the proxy name that you want to search for and click Search.

The name of the proxy for the inbound integration is /ARBA/CO_POLLING_CLIENT_REQRES.

The list of proxies that match the specified criteria appears.
4. From the list of proxies, click /ARBA/CO_POLLING_CLIENT_REQRES.

The Details of Consumer Proxy:<proxy name> page appears.
5. From the Configuration tab, click Create Logical Port. and select Manual Configuration.
6. Under General Configuration, specify the following:
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○ Logical Port name.
○ Description
○ Check the Logical Port is Default check box.

7. Click Next.
The New Manual Configuration of Logical Port for Consumer Proxy <proxy name> page appears.

8. From the Authentication Settings, select Shared Secret-based authentication, select User ID/Password, 
and enter the User ID and the Password in the corresponding fields that appear.

Note
User ID is the name of the sourcing realm and the password is the shared secret that you configured in the 
SAP Ariba application.

9. Click Next.

The Transport Bindings page appears.
10. In the Transport Bindings page, specify the following:

○ URL Access Path:
○ /SM/soap/PollingService for the polling client (inbound integration).

○ Computer Name of Access URL: Specify the path to your SAP Ariba application.
For example, s1.ariba.com.

○ Port Number of Access URL: 443
○ URL Protocol Information: HTTPS

11. Click Next.
The Reliable Messaging (Asynchr.) page appears.

12. In the Reliable Messaging (Asynchr.) page, specify the following:

○ RM Protocol to SAP RM.

Note
SAP Ariba Supplier Management solutions integration with SAP ERP does not support WS-RM .

○ Message ID Protocol to Suppress ID Transfer.

13. Click Finish to save the changes.

Note
When you do a Web Service Ping, you might receive a “Web service ping failed (RC=403). Service Ping 
ERROR: Forbidden.” This is expected behavior and does not indicate any error in the SOAMANAGER 
configuration.

Next Steps

Repeat the SOAMANAGER configuration for the following proxies:

● CO_MDG_BP_RPLCTRQ for outbound integrations from SAP ERP.
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● CO_MDG_BP_RPLCTCO for outbound confirmations from SAP ERP.

Except for the URL access path, the configuration remains the same as that for /ARBA/
CO_POLLING_CLIENT_REQRES.

● For CO_MDG_BP_RPLCTRQ, the URL access path is /SM/soap/BPIntegrationServiceIn.
● For CO_MDG_BP_RPLCTCO, the URL access path is /SM/soap/BPIntegrationServiceInConf.

How to install the SSL server certificate

Context

To enable HTTPS connection between SAP Aribaand SAP ERP, install SSL server certificate.

Procedure

1. Open your browser in Internet Explorer or Google Chrome and download the SSL certificate for the URL that 
you have configured in SOAMANAGER.

2. Click the Secure Lock indicator on the address bar and then click the Connection tab.
3. Click the Certificate information link to download the certificates.

The Certificate dialog box appears.
4. Click the Details tab and then click Copy to File.

The Certificate Export Wizard appears.
5. Follow the steps in the Certificate Export Wizard. Ensure that you select the DER encoded binary X.509 

(.CER) option. This option is selected by default.
6. Specify the path where you want to store the certificates. Click Finish.
7. On your ERP system, go to STRUST and click SSL Client SSL Client(Anonymous).
8. Click the Import Certificates button and then choose the path where you exported the certificates.
9. Click Allow and then Continue to download the certificates.
10. Click Add to Certificate List.

You will see a message that you have added the certificates successfully.

Note
Ensure that you save the newly added certificates. This notifies the ICM about the new certificates you have 
just imported.

11. After you have saved the entries in the STRUST, go to the Tcode SMICM.

12. On the Administration menu, click ICM > Exit Soft and then Global.
13. In the Internet Communication Manager dialog box, Do you really want to restart all ICM processes in the 

system?, click Yes.
14. On the Administration menu, click ICM > Exit Hard and then Global. Restart the services for the Exit Global.
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15. In the Internet Communication Manager dialog box, Do you really want to restart all ICM processes in the 
system?, click Yes.

16. Test your connection using SOAMANAGER.

17. On the Search tab, select Consumer Proxy in the Search By pull-down list.
18. Enter first few characters of the proxy name in the Search Pattern text box and select Both Names in the 

Field pull-down list.
19. From the list of results, select one or more of the following proxies:

○ /ARBA/CO_POLLING_CLIENT_REQRES for the polling client.
○ CO_MDG_BP_RPLCTRQ for DRFOUT.
○ CO_MDG_BP_RPLCTCO for confirmation out.

20.On the Configurations tab, click Ping Web Service.

○ In case you see an ICM_HTTP_SSL_ERROR, verify that the SSL certificate is valid and the configuration is 
correct.

○ If the connection is successful, you see a message saying the connection is successful.

How to configure mediated connectivity

Note
The integration scenario [page 75] configuration explained in this section is specific to the polling client-based 
inbound integration from SAP Ariba Supplier Lifecycle and Performance to SAP ERP. SAP Ariba does not 
provide an out-of-the-box integration option for outbound integration and confirmation out from SAP ERP to 
SAP Ariba Supplier Lifecycle and Performance. You might want to create custom configuration scenarios [page 
78] for the outbound integration and confirmation out.

This section contains the following topics:

In this section:

Requirements for mediated connectivity [page 74]

How to configure the integration scenario [page 75]

How to configure SSL certificate for mediated connectivity [page 77]

How to configure shared secret authentication for mediated connectivity [page 78]

How to create a configuration scenario [page 78]

Requirements for mediated connectivity

Note
The mediated connectivity configuration explained in this section is specific to the polling client-based inbound 
integration between SAP Ariba Supplier Lifecycle and Performance and SAP ERP. SAP Ariba does not provide 

74 P U B L I C

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA

Integrating SAP Ariba Supplier Lifecycle and Performance with SAP ERP



an out-of-the-box integration option for outbound integration or confirmation out. For the outbound integration 
and confirmation out services, you can create custom configuration scenarios [page 78].

● Install the latest SAP Ariba Supplier Lifecycle and Performance transports and TPZ file. For more information, 
see Installing and configuring SAP Ariba Supplier Lifecycle and Performance integration with SAP ERP [page 
68]. You can import the TPZ file XI7_1_ARIBA_SUPPLIER_MANAGEMENT_2.0_of_ariba.com.tpz to the 
Enterprise Services Repository on SAP Process Integration.

● Configure SSL certificate for HTTPS connection. For more information, see How to configure SSL certificate 
for mediated connectivity [page 77]

● Configure the Shared Secret password as explained in How to set up SAP ERP credentials in SAP Ariba [page 
82].

● Complete the following configuration in the System Landscape Directory (SLD):
○ Ensure that the software component ARIBA_SUPPLIER_MANAGEMENT 2.0 of ariba.com is available in 

the System Landscape Directory (SLD). You need to import the CIM file from 
AribaSupplierManagement2.0.SoftwareCatalog.zip.

○ (For SAP ERP) Download and configure the SAP_BS_FOUNDATION version that corresponds to the SAP BS 
Foundation version that you run as a dependent component of
ARIBA_SUPPLIER_MANAGEMENT 2.0 of ariba.com.
(For SAP S/4HANA) Download and configure S4CORE as a dependent component of 
ARIBA_SUPPLIER_MANAGEMENT 2.0 of ariba.com.
You can use the Define Prerequisite Software Component Versions button on the Dependencies tab of 
the ARIBA_SUPPLIER_MANAGEMENT 2.0 of ariba.com page to specify the dependent component.

For more information, see About Configuring the System Landscape Directory in the Integrating SAP Ariba 
cloud solutions procurement and invoicing data with SAP ERP and SAP S/4HANA .

● Set up the proxy configuration between the SAP ERP and SAP Process Integration to send and receive the 
proxy request and response messages. For more information, see How to configure the proxy on SAP ERP 
systems [page 111].

● If you have configured a logical port for the proxy, delete or deactivate the logical port in SOAMANAGER and 
remove the logical port information from the /ARBA/SM_SEQNUM table.

How to configure the integration scenario

Context

Note
The integration scenario configuration explained in this topic is specific to the inbound integration between SAP 
Ariba supplier management solutions and SAP ERP. SAP Ariba does not provide an out-of-the-box integration 
option for outbound integration or confirmation out. You might want to create your own custom dual stack 
[page 79] or single stack [page 80] configuration scenario for the outbound integration and confirmation 
out.
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Procedure

1. From the SAP NetWeaver Process Integration main page, select Integration Directory > Integration Builder, 
and then log in to the Configuration: Integration Builder application.

2. In the Integration Builder page, select Tools > Apply Model from ES Repository.
3. In the first screen of the Transfer Model from ES Repository wizard > Select ES Repository Model and then 

click Process Integration Scenario.
4. Click the Name field and then click the Display Input Help pull-down menu and then click Input Help.
5. Select AR_Supplier_Management from the Select Process Integration Scenario from Enterprise Services 

Repository screen.
6. Click Apply. The Transfer Model from ES Repository wizard appears. The Namespace and the Software 

Component Version is available in the wizard.
7. Click Continue and then click Close. Based on the value you set in the Select Process Integration Scenario 

from Enterprise Services Repository field, this completes the export or import configuration scenario .
8. In the Model Configurator, click the Assign Component button.
9. In the Select Component View for Configuration page, select the Business System Components for A2A 

tab to assign components for your SAP ERP.
10. Click the Insert Line button ('+') to add a component entry in the table if no component entry line is present.
11. Click the row under the Communication Component column, then click the Value List drop down and select 

Value List ..F4. Select the communication component name, SAP ERP, from the selection list and click Apply.
12. Click the Next Application Component button (the right arrow) to go to the next screen in the window.
13. In the Model Configurator page, choose the Business System Components for A2A tab to assign the 

communication component for your SAP Ariba solution.
14. Click the Insert Line button (’+’) to add a component entry in the table if no component entry line is present.
15. Click the row under the Communication Component column, then click the Value List dropdown and choose 

Value List ..F4. Choose the communication component name for the business system from the selection list 
and click Apply.

16. Click the Save Settings button to save the changes.
17. In the Model Configurator page, click the Configure Connections button. You must assign a Communication 

Channel to set up the connections.
18. In the Connections from Component Assignment tab, click the empty Communication Channel cell 

corresponding to the to the business system component value.
19. Click the Value List dropdown and select Value List ..F4. Choose the communication component and click 

Apply.
20.Choose the Proxy Sender communication channel from the selection list and click Apply.

Note
You require the Proxy Sender communication channel only for a single stack Java machine. If you are using 
a dual stack Java machine, the Communication Channel cell must be left blank.

21. Click the New Communication Channel button (the icon at the top left) on the Communication Channels 
page to start the Create Communication Channel wizard.

22. Click Continue and in the next page click the Name field, then click the Display Input Help dropdown list and 
select Input Help. Select the following Communication Channel Template:
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CCT_PollingClient_SOAP_Receiver 
23.Click Finish. The Model Configurator window appears.
24.In the Model Configurator, click the Create Configuration Object button.
25. In the Create Configuration Object window, do the following:

○ Click Generation in the General section.
○ Select the Receiver Determination, and Interface Determination checkboxes in the Scope of 

Generation section.
26.Click Create New in the Change List for Generated Objects section. The text box already contains an object 

name that you can use or modify.
27. Click Start to begin generating objects.
28.After the object generation is complete, click Apply to save the new configuration settings. Close the log that is 

created without saving. You can save it, if required.
29.Edit the communication channel you created and specify the following settings:

○ Target URL:https://<SAPAribaSMdomain>/SM/soap/PollingService.
○ User name and Password for shared secret authentication [page 78]. User name is name of the 

sourcing realm.
30.Save the changes and activate the configuration scenario along with its associated objects.

How to configure SSL certificate for mediated connectivity

Context

The SSL certificate enables the SAP Process Integration to successfully establish an SSL connection with the SAP 
Ariba application. To enable HTTPS connection over mediated connectivity, configure the SSL certificate.

Procedure

1. To download the SSL certificate from the SAP Ariba application URL, follow these steps.
1. Open your browser in Internet Explorer or Google Chrome, and download the SSL certificate for the URL 

that you configured in the SOAP communication channel.
2. Click the Secure Lock indicator on the address bar and then, click the Connection tab.
3. Click the Certificate information link to download the certificates. The Certificate dialog box appears.
4. Click the Details tab and then click Copy to File. The Certificate Export Wizard appears.
5. Follow the steps in the Certificate Export Wizard. Ensure that you select the DER encoded binary X.509 

(.CER) option. This option is selected by default.
6. Specify the path where you want to store the certificates and click Finish.

2. The SSL client certificates that SOAP Adapter uses to connect to the SAP Ariba application must be stored in 
the SAP Process Integration keystore.

3. Go to the SAP Process Integration main page and click NetWeaver Administration Configuration 
Management .
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4. Click Certificate and Keys.
5. Search for the default keystore TrustedCAs and Click Import Entry button.

Note
Alternatively, you can add the SSL client certificate to a keystore you created.

6. Select X.509 Certificate option from the Select Entry Type drop-down list in the Entry Import window.
7. Select file and import.

How to configure shared secret authentication for mediated connectivity

Procedure

1. Open the Configuration Integration Builder from the main SAP Process Integration page.
2. In the Objects tab of the Integration Builder, click Communication Channel.
3. Click Edit button that corresponds to the Communication Channel, and click Configure User Authentication.
4. In the Target URL field, specify the URL of the Supplier Management system. For Example:

○ http://<SAP Ariba Supplier Lifecycle and Performance system URL>/SM/soap/
PollingService for inbound integration.

○ http://<SAP Ariba Supplier Lifecycle and Performance system URL>/SM/soap/
BPIntegrationServiceIn for outbound integration.

○ http://<SAP Ariba Supplier Lifecycle and Performance system URL>/SM/soap/
BPIntegrationServiceInConf for confirmation out.

5. In the User text box, enter the name of the Sourcing realm.
6. In the Password text box, enter the same shared secret that you specified on the Integration Toolkit Security 

page of the SAP Ariba application.
7. Save and activate the communication channel.

How to create a configuration scenario

For outbound integration and the confirmation out service, you need to configure custom configuration scenarios.

This section contains the following topics:

In this section:

How to create a configuration scenario on a dual stack system [page 79]

How to create a configuration scenario on a single stack system [page 80]

78 P U B L I C

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA

Integrating SAP Ariba Supplier Lifecycle and Performance with SAP ERP



How to create a configuration scenario on a dual stack system

Context

For outbound integration and the confirmation out service from SAP ERP to SAP Ariba supplier management 
solutions, you must set up configuration scenarios. This topic contains the steps for creating a configuration 
scenario on a dual stack system.

Procedure

1. From the SAP Process Integration main page, log in to Integration Directory Integration Builder .
2. Right click the object type Configuration Scenario in the left pane, and click Create from the popup menu.

The Create object page appears.
3. Specify a name for the configuration scenario and click Create.

For example, you may name the configuration scenario for outbound integration as 
AR_Supplier_Outbound_DRF, and the one for the confirmation out service as 
AR_Supplier_Outbound_Confirmation.

The Edit Configuration Scenario page appears.
4. Go to the the Object tab and add a business system each for SAP ERP and SAP Ariba Supplier Management.
5. Create a communication channel for the receiver and specify the following settings:

○ Specify a name for the communication channel. For example, you may name the receiver communication 
channel for outbound integration as CC_DRF_SOAP_Receiver, and the communication channel for 
confirmation out as CC_Con_SOAP_Receiver.

○ Set the Adapter Type to SOAP.
○ Set the Message Protocol to SOAP 1.1.
○ Set one of the following values for Target URL:

For outbound integration: https://<domain name>/SM/soap/BPIntegrationServiceIn.
For confirmation out: https://<domain name>/SM/soap/BPIntegrationServiceInConf.

○ Add the communication channel to the Configuration Scenario.
6. Create Receiver Determination and configure the following settings:

○ Specify the SAP ERP business system as the communication component for Receiver Determination.
○ For Receiver Determination for the outbound integration, set Sender interface to 

BusinessPartnerSUITEBulkReplicateRequest_Out.
○ For Receiver Determination for the confirmation out service, set Sender interface to 

BusinessPartnerSUITEBulkReplicateConfirmation_Out.
○ Add a local rule to Receiver Determination and set the SAP AribaSupplier Management business system 

as the communication component for the rule.
○ If the newly-created Receiver Determination is not added to the configuration scenario, add Receiver 

Determination to the configuration scenario.
7. Create Interface Determination and configure the following settings:

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA
Integrating SAP Ariba Supplier Lifecycle and Performance with SAP ERP P U B L I C 79



○ Specify the SAP ERP business system as the communication component.
○ Set the Sender Interface for the outbound integration to 

BusinessPartnerSUITEBulkReplicateRequest_Out.
○ Set the Sender Interface for the confirmation out service to 

BusinessPartnerSUITEBulkReplicateConfirmation_Out.
○ Set Receiver Communication Component to the SAP Ariba Supplier Management business system.
○ Set the following values for Receiver Interface:

Integration Type Name Namespace

Outbound integration BusinessPartnerSUITEBulk 
ReplicateRequest_In

https://<domainname>/SM/ soap/
BPIntegrationServiceIn

Confirmation out BusinessPartnerSUITEBulk 
ReplicateConfirmation_In

https://<domainname>/SM/ soap/
BPIntegrationServiceInConf

Note
Interface Operation Mapping is not required.

8. Define Receiver Agreement and configure the following settings: After you create the Receiver Agreement, 
specify the Receiver Communication channel CC_DRF_SOAP_Receiver.

○ Set the Sender Communication Component to the SAP ERP business system.
○ Set the Receiver Communication Component to the SAP Ariba Supplier Management business system.
○ Set one of the following values for the Receiver Interface:

BusinessPartnerSUITEBulkReplicateRequest_In for outbound integration.
BusinessPartnerSUITEBulkReplicateConfirmation_In for the confirmation out service.

○ After you define Receiver Agreement, specify the Receiver Communication channel.
For example, you may set the Receiver Communication channel for outbound integration as 
CC_DRF_SOAP_Receiver, and Receiver Communication channel for the confirmation out service as 
CC_Con_SOAP_Receiver.

9. Save the objects and the configuration scenario.
10. Click Configuration Scenario on the menu bar and select Activate. The Activate Change list popup appears. 

Select the newly created or modified objects and click Activate.

Repeat the steps to create configuration scenarios for both outbound integration and the confirmation out 
service.

How to create a configuration scenario on a single stack system

Context

For outbound integration and the confirmation out service from SAP ERP to SAP Ariba supplier management 
solutions, you must set up configuration scenarios. This topic contains the steps for creating a configuration 
scenario on a single stack system.
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Procedure

1. From the SAP Process Integration main page, log in to Integration Directory Integration Builder .
2. Right click the object type Configuration Scenario in the left pane, and click Create from the popup menu.

The Create object page appears.
3. Specify a name for the configuration scenario and click Create.

For example, you may name the configuration scenario for outbound integration as 
AR_Supplier_Outbound_DRF, and the one for the confirmation out service as 
AR_Supplier_Outbound_Confirmation.

The Edit Configuration Scenario page appears.
4. Go to the the Object tab and add a business system each for SAP ERP and SAP Ariba Supplier Management.
5. Create a communication channel for the sender and specify the following settings.

○ Specify a name for the communication channel. For example, CC_SOAP_Sender.
○ Set the Adapter Type to SOAP.
○ Set the Message Protocol to XI 3.0.
○ Add the communication channel to the Configuration Scenario.

6. Create a communication channel for the receiver and specify the following settings:

○ Specify a name for the communication channel. For example, you may name the receiver communication 
channel for outbound integration as CC_DRF_SOAP_Receiver, and the communication channel for 
confirmation out as CC_Con_SOAP_Receiver.

○ Set the Adapter Type to SOAP.
○ Set the Message Protocol to SOAP 1.1.
○ Set one of the following values for Target URL:

For outbound integration: https://<domain name>/SM/soap/BPIntegrationServiceIn.
For confirmation out: https://<domain name>/SM/soap/BPIntegrationServiceInConf.

○ Add the communication channel to the Configuration Scenario.
7. Define Integrated Configuration and configure the following settings.

○ Set the Communication Component to the SAP ERP business system.
○ Set one of the following values for the sender interface:

For outbound integration: BusinessPartnerSUITEBulkReplicateRequest_Out
For confirmation out: BusinessPartnerSUITEBulkReplicateConfirmation_Out

○ On the Inbound Processing tab, set the Sender Communication Channel to CC_SOAP_Sender.
○ On the Receiver tab, specify a local rule and set the SAP Ariba Supplier Management business system as 

the communication component for the rule.
Set the following values for Receiver Interface:

Integration Type Name Namespace

Outbound integration BusinessPartnerSUITEBulk 
ReplicateRequest_In

https://<domain name>/SM/ soap/
BPIntegrationServiceIn
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Integration Type Name Namespace

Confirmation out BusinessPartnerSUITEBulk 
ReplicateConfirmation_In

https://<domainname>/SM/ soap/
BPIntegrationServiceInConf

Note
Interface Operation Mapping is not required.

○ On the Outbound Processing tab, specify the communication channels for receiver.
For example, you may name the receiver communication channel for the outbound integration as 
CC_DRF_SOAP_Receiver, and the one for the confirmation out service as CC_Con_SOAP_Receiver.

○ If the Integrated Configuration is not part of the Configuration Scenario, add the Integrated Configuration 
to the configuration scenario.

8. Save the objects and the configuration scenario.
9. Click Configuration Scenario on the menu bar and select Activate. The Activate Change list popup appears. 

Select the newly created or modified objects and click Activate.

Repeat the steps to create configuration scenarios for both outbound integration and the confirmation out 
service.

How to set up SAP ERP credentials in SAP Ariba

Prerequisites

You must be a member of the SM ERP Admin group in order to manage ERP integration settings in the SM Admin 
area.

Context

Integration configurations in SM Admin only support shared secret authentication for integration. It does not 
support certificate authentication. The shared secret you use here does not have to be the same password you use 
for other SAP Ariba integration configurations.

Procedure

1. On the dashboard, click Manage SM Admin .
2. Click ERP Integration.
3. In the Enter ERP Credentials area, enter the following information:
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○ The business or ERP system ID of the SAP ERP system, which is the ID the ERP system uses to identify 
itself in all messages.

○ The shared secret password you want to use for this integration setup.
4. Click Save.

Customizing supplier master data integration
SAP Ariba supplier management solutions use MDG business partner interface structure to store supplier master 
data. However, SAP Ariba supplier management solutions integration with SAP ERP supports extension of the 
business partner data structure to enable you to use custom fields to address your specific requirements.

The following structures have been modified to include the GenericCustomField element and the 
genericCustomFieldListCompleteTransmissionIndicator attribute:

● BPSUITERplctReqSuplr for supplier information.
● BPSUITERplctReqBkDets for bank details.
● BPSUITERplctReqAcctgInfo for accounting information.
● BPSUITERplctReqBP for business partner information.

The GenericCustomField element contains the following attributes:

Attribute Name Attribute Type Description

Name GenericCustomFieldName Name of the field. This is both the default 
display name and also the identifier for 
the field.

Note
The following attributes are currently not used by the integration. These attributes are added for future use.

Type GenericCustomFieldType General type of the field, selected from 
the GenericCustomerFieldType 
enumerated values. If it is not specified 
or not recognized, the type defaults to 
Text.

Title GenericCustomFieldTitle Display title of the field.

Description GenericCustomFieldDescription Description of the field.

Language Code LanguageCode SAP Language code for the title and de­
scription of the field. If no value is speci­
fied, it defaults to en.

Table GenericCustomFieldMappingName Sender's table name where the value of 
the mapped field is stored.
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Attribute Name Attribute Type Description

Field GenericCustomFieldMappingName Sender's field name in the table where 
the value of the mapped field is stored.

Check Table GenericCustomFieldMappingName Sender's name of the check table used 
to validate the code values.

Receiver Table GenericCustomFieldMappingName Receiver's table name, if any, where the 
value of the mapped field is stored. recei­
verTable and receiverField should ap­
pear together, or not at all.

Receiver Field GenericCustomFieldMappingName Receiver's field name in the table where 
the value of this mapped field is stored. 
receiverTable and receiverField should 
appear together, or not at all.

Receiver Check Table GenericCustomFieldMappingName Receiver's name of the check table used 
to validate the code values.

Maximum Length GenericCustomFieldMappingName Maximum length of the value string in 
characters, for input validation, if 
type="Text".

Minimum Length NumberValue Minimum length of the value string in 
characters, for input validation, if 
type="Text".

Pattern NumberValue Pattern A regular expression that must match 
valid input, if type="Text".

Total Digits NumberValue Maximum total digits, for input valida­
tion, if type="Decimal".

Fraction Digits NumberValue Maximum digits in the fractional part, for 
input validation, if type="Decimal".

Maximum Inclusive Inclusive Maximum decimal value, for input valida­
tion, if type="Decimal".

Minimum Inclusive Inclusive Minimum decimal value, for input valida­
tion, if type="Decimal".

Display Restrictions GenericCustomFieldRestrictions A comma separated list of display con­
texts in which this field should be dis­
played.

Edit Restrictions GenericCustomFieldRestrictions A comma separated list of display con­
texts in which this field should be edita­
ble.
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If you need to extend your business partner data to include these custom fields, you can implement the following 
BAdIs of the enhancement spot MDG_SE_SPOT_BPBUPA:

● MDG_SE_BP_BULK_REPLRQ_IN to extend the business partner data while creating the record in ERP.
● MDG_SE_BP_BULK_REPLRQ_OUT to extend the business partner data in ERP while sending to SAP Ariba 

Supplier Lifecycle and Performance.

Customizations using the MDG_SE_SPOT_BPBUPA enhancement spot are specific to the Business Partner tables in 
SAP ERP.

You can implement the BAdI CVI_CUSTOM_MAPPER to replicate these extensions in the vendor master data tables. 
The CVI_CUSTOM_MAPPER BAdI enables you to map customizations in business partner tables to vendor master 
data tables.

In this section:

ABAP example code for processing incoming GenericCustomField data [page 85]

How to create custom message mappings in SAP Process Integration [page 86]

Related Information

ABAP example code for processing incoming GenericCustomField data [page 85]

ABAP example code for processing incoming 
GenericCustomField data

The following example contains a sample ABAP code for processing incoming GenericCustomField data.

METHOD if_mdg_se_bp_bulk_replrq_in~inbound_processing. ***Implementation for customer data
***Local Declaration for Internal table
   DATA: lt_ariba_generic_data TYPE /arba/generic_custom_fiel_tab1.
***Local Declaration for Work Area
   DATA: ls_ariba_generic_data TYPE /arba/generic_custom_field.
***Local Declaration for variable for generic fields
   DATA: lv_sup_creator TYPE string,
         lv_sup_sponsor TYPE string.
***Field symbol declaration
   FIELD-SYMBOLS:<fs_org_data>  TYPE   bus_ei_bupa_central_data,
                 <fs_org_datax> TYPE   bus_ei_bupa_central_data_xflag.
***Assigment of genereic field
   lt_ariba_generic_data = in-business_partner-supplier-/arba/generic_custom_field.
***Assign the field symbol
   ASSIGN out-partner-central_data-common-data TO <fs_org_data>.
   ASSIGN out-partner-central_data-common-datax TO <fs_org_datax>.
***Loop at internal table for custom field.
   LOOP AT lt_ariba_generic_data INTO ls_ariba_generic_data.
    IF ls_ariba_generic_data-name EQ 'SupplierCreator'.
       lv_sup_creator = ls_ariba_generic_data-content.
    ENDIF.
    IF ls_ariba_generic_data-name EQ 'SupplierSourcingSponsor'.
       lv_sup_sponsor = ls_ariba_generic_data-content.
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    ENDIF.
   ENDLOOP.
***Updating the value into the  MDG_BS_BP_S_EXTERN
    IF lv_sup_creator IS NOT INITIAL OR lv_sup_sponsor IS NOT INITIAL.
        IF <fs_org_data> IS ASSIGNED.
        <fs_org_data>-zsup_creator = lv_sup_creator.
        <fs_org_data>-zsup_sponsor = lv_sup_sponsor.
    ENDIF.
    IF <fs_org_datax> IS ASSIGNED.
        IF <fs_org_data>-zsup_creator IS NOT INITIAL.
        <fs_org_datax>-zsup_creator = abap_true.
        ENDIF.
        IF <fs_org_data>-zsup_sponsor IS NOT INITIAL.
        <fs_org_datax>-zsup_sponsor  = abap_true.
        ENDIF.
    ENDIF.
  ENDIF. ENDMETHOD.

The LOOP AT lt_ariba_generic_data INTO ls_ariba_generic_data code creates a loop for the list of 
GenericCustomField data in the structure generated from the SOAP WSDL. You could add your processing at 
this point in the code to check for GenericCustomField records with specific names and process each of the 
custom fields appropriately.

You can choose which of the custom fields you need to implement and at which extension [page 83] point. You can 
specify the name of the field and also specify to which fields in your SAP Ariba supplier management solution the 
custom fields you add map to.

To create custom fields to SAP Ariba supplier management solutions, you can implement the 
BAdIMDG_SE_BP_BULK_REPLRQ_OUT, which extends the master data when SAP ERP sends the data to the SAP 
Ariba supplier management solution.

How to create custom message mappings in SAP Process 
Integration

Context

To extend the business partner data, you can create custom message mappings in the SAP Process Integration.

Procedure

1. From the SAP Process Integration main page, click Enterprise Service Repository.
2. Select the Software Component Version ARIBA_SUPPLIER_MANAGEMENT 2.0 of ariba.com.

3. Select the customization namespace http://ariba.com/xi/SupplierManagement/Cutomization.

4. Right click and create new mapping and operation mapping for customization.
5. Customize the mapping to suit your requirements, create new message mapping by assigning the request and 

source message type.
6. Save the changes and activate the mapping.
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7. Assign the message mapping in Operation Mapping.
8. Save and activate the Operation mapping.
9. Go to the Integration Directory and click Integration Builder.
10. Click the Configuration Scenario for Supplier Management.
11. Select Interface Determination and click the Edit icon.
12. Assign the operation mapping as per the customization in Interface Determination.
13. Save the changes and activate Interface Determination.

How to set up supplier data synchronization
Prerequisites

You must be a member of the SM ERP Admin group in order to set up supplier synchronization.

Context

Setting up supplier data synchronization involves choosing manual or automatic synchronization and specifying 
the supplier status at which synchronization occurs.

Automatic synchronization occurs automatically when the supplier reaches the specified status and is designed to 
synchronize all suppliers of that status in the SAP Ariba supplier management solution database with the ERP.

With manual synchronization, when the supplier reaches the specified status, an ERP synchronization link appears 
in the upper right corner of the supplier 360° view. A category or supplier manager clicks the link when they are 
ready to transact with the supplier. Otherwise, suppliers of that status are not synchronized with the ERP.

Note
The supplier data synchronization setting is for the initial synchronization of a supplier between SAP Ariba 
supplier management solution database and SAP ERP. Changes that are made to a synchronized record in the 
SAP Ariba supplier management solution are automatically transmitted to SAP ERP.

Procedure

1. On the dashboard, click Manage SM Admin .
2. Click ERP integration.
3. In the Initial supplier synchronization, choose either Automatic synchronization or Manual 

synchronization.
4. Choose one of the following statuses for initial synchronization:
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Status Description

Not Invited The supplier request has been approved and the supplier is 
created in the SAP Ariba supplier management solution da­
tabase, but the supplier has not been invited to register yet.

Invited The supplier has been invited to register. (Manual synchro­
nization only.)

In Registration The supplier has been sent the registration questionnaire. 
(Manual synchronization only.)

Pending Approval The approval flow for the registration has started and there 
is one final approval pending. (Manual synchronization 
only.)

Registered The supplier registration has been finally approved.

5. Click Save.

How to replicate Business Partner master data from 
SAP Ariba Supplier Lifecycle and Performance

Prerequisites

● Maintain values in the /ARBA/SM_SEQNUM table as explained in How to maintain table entries [page 69].
● Set up Direct Connectivity [page 70] or Mediated Connectivity [page 74]integration method between SAP 

Ariba Supplier Lifecycle and Performance and SAP ERP.

Context

You can replicate Business Partner master data from SAP Ariba Supplier Lifecycle and Performance in SAP ERP 
and Master Data Governance.

Tip
Always schedule this program to run at regular intervals. Use the sm36 transaction code to schedule the 
program to run in the background at regular intervals.
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Procedure

1. From SAP ERP, execute the /ARBA/SM_BUSINESS_PARTNER_PULL program.

The Ariba Supplier Lifecycle and Performance Business Partner Pull Interface window appears.
2. Choose one or more of the following options:

○ Business Partner Bulk Replicate Request. To import the supplier master data.
○ Business Partner Bulk Replicate Confirmation. To receive confirmation for the supplier master data 

import.
3. Click Execute.

How to monitor errors in SAP ERP
You can use one of the following transaction codes to monitor errors that might occur in the SAP Ariba Supplier 
Management solutions integration with SAP ERP:

● SLG1 [page 89]
● SRT_TOOLS [page 89]
● SXMB_MONI [page 90]

SLG1

1. Go to transaction code SLG1.
The Analyse Application Log screen appears.

2. In the Object field, enter /ARIBA/SM.
3. In the Subobject field, enter /ARIBA/SUB_SM.
4. Specify the filters.
5. Click the Execute icon.

The Display Logs screen lists the logs associated with the SAP Ariba Supplier Management solutions 
integration with SAP ERP.

SRT_TOOLS

1. Go to transaction code SRT_TOOL.
The SOA Runtime Tools window appears.

2. Click SOA Runtime Tools Monitoring Web Service Utilities: Message Monitor .
The Web Service Utilities: Message Monitor window appears.

3. Specify the filters and click the Execute icon.
The Web Service Utilities: Message Monitor page lists the errors, if any.
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SXMB_MONI

You can use the SXMB_MONI transaction code to view errors occurred on SAP Process Integration when you use 
the Mediated Connectivity integration method.
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Importing Ariba components and configuring 
integration methods

This chapter contains the following topics:

In this section:

How to import Ariba components [page 91]

How to maintain table entries for SAP Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 
92]

Configuring direct connectivity [page 99]

Configuring mediated connectivity [page 106]

How to import Ariba components
Procedure

1. Go to https://support.ariba.com/Connect/Log_In and log in using your user ID and password. If you do not 
have a User ID and Password for SAP Ariba Connect, contact your SAP Ariba account executive.

2. On the Home page, click Product Information and Documentation.
3. Click Cloud Integration in the Product Information section and then click Resources.

The Cloud Integration Resources page appears.
4. In the Integration Tools section, click Integration tools for Ariba Sourcing and Ariba Contract 

Management.
5. Go to the Integration Tools section, and click ABAP Transports for SAP ERP. If the list does not contain this 

entry, contact your SAP Ariba account executive.
6. Click Download and save the Ariba_Sourcing_SAP_Transports_V_CI_x.zip package.

7. Extract the contents of the ZIP file and import the transports to SAP ERP.
8. If you want to implement the feature over Mediated Connectivity, go back to the Integration tools for Ariba 

Sourcing and Ariba Contract Management page and click SAP NetWeaver PI Mapping from the Resources 
tab.

The Sourcing SAP NetWeaver PI Mapping page appears.
9. Click Download and save the Ariba_Sourcing_SAP_Netweaver_Repository_CIx.zip package.

10. Extract and import the relevant TPZ files into the SAP Process Integration.
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How to maintain table entries for SAP Ariba 
Sourcing and SAP Ariba Contracts integration with 
SAP ERP
You must maintain certain entries in the following tables for the integration between SAP ERP and SAP Ariba 
Sourcing to work:

● /ARBA/AUTH_PARAM [page 92]
● /ARBA/TVARV [page 93]

You can use the sm30 transaction code to access tables. To maintain a table, enter the name of the table in 
theTable/View field of the Maintain Table Views: Initial Screen, and click Maintain.

/ARBA/AUTH_PARAM

In the /ARBA/AUTH_PARAM table, maintain the following parameters.

Parameter Description Example

Solution Name of the SAP Ariba solution that you 
integrate SAP ERP with.

Ariba Sourcing

Ariba Realm ID The name of your company as config­
ured in the SAP Ariba application.

s4All

Wait Time Number of minutes to wait before SAP 
ERP attempts to reconnect with the SAP 
Ariba application if connection attempts 
encounter temporary errors such as 
service not available.

02

Logical Port Name of the logical port that you config­
ure as part of the SOAMANAGER config­
uration.

Note
Not applicable for SAP Ariba Sourcing 
integration for Product Sourcing.

Not applicable for SAP Ariba Sourcing in­
tegration for Product Sourcing.
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Parameter Description Example

Is Parent Whether the realm is a parent realm.

A checked Is Parent check box indi­
cates that the corresponding realm is a 
parent realm. An unchecked Is 
Parent check box indicates that the 
corresponding realm is a child realm.

Note
Not applicable for SAP Ariba Sourcing 
integration for Product Sourcing.

Not applicable for SAP Ariba Sourcing in­
tegration for Product Sourcing.

/ARBA/TVARV

Maintain the following parameters in the /ARBA/TVARV table:

● /ARBA/EXTERNAL_SID is a mandatory parameter in the /ARBA/TVARV table that you need to configure for 
the direct connectivity to work. You must specify a name for the SAP ERP system in /ARBA/EXTERNAL_SID 
and enter the same name in the Service Manager Site Manager Customer Site Master Data 
Manager External System Configuration Create External System  window of the SAP Ariba Sourcing 
application. .

Field Values for

Variable Name /ARBA/EXTERNAL_SID

Field Name --

Selection Category P

Number 0

Char 20 --

Char 20 --

INCL/EXCL I

Options EQ

Selection Value <External system ID. For example, SAPERPSYSTEM1>

Selection Value --

● /ARBA/TEMP_DIRECTORY is a mandatory parameter for exporting master data over file-based integrations.
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Note
This parameter is not required for web services integrations, such as bill of materials integration, that do 
not use file channels.

Field Values for TEMP_DIRECTORY

Variable Name /ARBA/TEMP_DIRECTORY

Field Name --

Selection Category P

Number 0

Char 20 --

Char 20 --

INCL/EXCL I

Options EQ

Selection Value The file path for extracting master data from the CSV files. For example, ./
MASTERDATA

Selection Value --

● /ARBA/SPLIT_NOMREC is an optional parameter in the /ARBA/TVARV table. Configure this parameter if you 
want to split the full load export of material master data into multiple batches. For example, if you set /ARBA/
SPLIT_NOMREC to 3000 when there are 10,000 material master data records, SAP ERP exports the records in 
four batches that include three batches of 3000 records each and one batch that contains 1000 records.

Field Values for

Variable Name /ARBA/SPLIT_NOMREC

Field Name --

Selection Category P

Number 0

Char 20 --

Char 20 --

INCL/EXCL I

Options EQ
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Field Values for

Selection Value Number of records that you need to export in a batch. For example, 2000.

Selection Value --

● /ARBA/SPLIT_BOM_NOMREC is an optional parameter in the /ARBA/TVARV table. Configure this parameter if 
you want to split the bill of materials full load export into multiple batches. For example, if you set /ARBA/
SPLIT_BOM_NOMREC to 300 when there are 1,000 records, SAP ERP exports the records in four batches that 
include three batches of 300 records each and one batch that contains 100 records.

Field Values for

Variable Name /ARBA/SPLIT_BOM_NOMREC

Field Name --

Selection Category P

Number 0

Char 20 --

Char 20 --

INCL/EXCL I

Options EQ

Selection Value Number of records that you need to export in a batch. For example, 300.

Selection Value --

● DC_WAITTIME is a parameter in the /ARBA/TVARV table. Configure this parameter to specify the number of 
seconds that SAP ERP should wait between two Direct Connectivity calls to the SAP Ariba application. The 
default value is one second. This parameter is mandatory if you configure the /ARBA/SPLIT_NOMREC 
parameter to split the export into multiple batches.

Field Values for

Variable Name DC_WAITTIME

Field Name --

Selection Category P

Number 0

Char 20 --

Char 20 --
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Field Values for

INCL/EXCL I

Options EQ

Selection Value Number of seconds SAP ERP should wait between two Direct Connectivity calls. 
The default value is one (1) second.

Selection Value --

● /ARBA/BILLOFMATERIALS_EXPORT is an optional parameter that you can use to filter bill of materials master 
data when you export bill of materials from SAP ERP to SAP Ariba Sourcing.

Field Values for BILLOFMATERIALS_EXPORT

Variable Name /ARBA/BILLOFMATERIALS_EXPORT

Field Name The filtering criterion that you want to apply. For example:

STLNR for bill of materials number.
STLAL for alternative BOM.
MATNR for material number.
WERKS for plant.
STLAN for BOM usage.

Selection Category S

Number Number of the filter criterion you configure. For example, 0, 1, 2, and so on

Char 20 --

Char 20 --

INCL/EXCL I or E

Options EQ, NE, or BT

Selection Value Filter value for the criterion you set for Field. For example the Bill of materials 
number.

Selection Value Filter value for the range if you set Options to BT, which indicates a range.

Note
You can configure multiple filters by incrementing the value of Number by 1. For example, you can set 
Number to 1 for the second filter you configure.

● /ARBA/MATERIAL_CHARACT is an optional parameter that you can use to filter material classification data 
when you export bill of materials from SAP ERP to SAP Ariba Sourcing.
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Field Values for MATERIAL_CHARACT

Variable Name /ARBA/MATERIAL_CHARACT

Field Name ATINN

Selection Category S

Number 0

Char 20 --

Char 20 --

INCL/EXCL I or E

Options EQ

Selection Value CharacteristicInternalValue based on which you want to filter the output.

Selection Value --

Note
You can configure multiple filters by incrementing the value of Number by 1. For example, you can set 
Number to 1 for the second filter you configure.

● /ARBA/MATERIAL_ONLY_AML is an optional parameter that you can use to filter the Manufacturer Parts List 
data for a specific material number when you export Manufacturer Parts List from SAP ERP to SAP Ariba 
Sourcing.

Field Values for MATERIAL_CHARACT

Variable Name /ARBA/MATERIAL_ONLY_AML

Field Name MATNR

Selection Category S

Number 0

Char 20 --

Char 20 --

INCL/EXCL I or E

Options EQ

Selection Value The HERS material number.
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Field Values for MATERIAL_CHARACT

Selection Value --

Note
You can configure multiple filters by incrementing the value of Number by 1. For example, you can set 
Number to 1 for the second filter you configure.

● /ARBA/CLASS_TYPE is a parameter that you need to maintain if you want to extract material classification 
data when you export material master data from SAP ERP to SAP Ariba Sourcing.

Field Values for CLASS_TYPE

Variable Name /ARBA/CLASS_TYPE

Field Name --

Selection Category P

Number 0

Char 20 --

Char 20 --

INCL/EXCL I or E

Options EQ

Selection Value Class type value, for example 001.

Selection Value --

Note
You can configure multiple filters by incrementing the value of Number by 1. For example, you can set 
Number to 1 for the second filter you configure.

● /ARBA/CLASS is a parameter that you need to maintain if you want to extract material classification data when 
you export material master data from SAP ERP to SAP Ariba Sourcing.

Field Values for CLASS

Variable Name /ARBA/CLASS

Field Name --

Selection Category P

98 P U B L I C

Configuration guide for sourcing, contracts, and supplier data integration with SAP ERP and 
SAP S/4HANA

Importing Ariba components and configuring integration methods



Field Values for CLASS

Number 0

Char 20 --

Char 20 --

INCL/EXCL I or E

Options EQ

Selection Value Class value, for example CL1111.

Selection Value --

Note
You can configure multiple filters by incrementing the value of Number by 1. For example, you can set 
Number to 1 for the second filter you configure.

Configuring direct connectivity
This section contains the following topics:

About direct connectivity

Direct connectivity enables direct communication between SAP ERP and the SAP Ariba application without any 
middleware. When you use the direct connectivity integration method, you can configure a connection between 
the logical port of the consumer proxy (SAP ERP) and the endpoint of the provider proxy (SAP Ariba application).

Direct connectivity integration method is supported only for master data integration. Transactional data 
integrations do not work over direct connectivity.

SAP Ariba cloud integration transfers master data over direct connectivity in one of the following methods:

● CSV files embedded in SOAP message headers
● Embedded data in SOAP message body

You can use the SOAMANAGER transaction to configure Direct Connectivity integration method. For more 
information about the SOAMANAGER settings, see How to configure SOAMANAGER [page 100].
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Prerequisites

● Install the latest SAP Ariba transports as explained in How to import Ariba components [page 91].
● Maintain the entries in /ARBA/AUTH_PARAM and /ARBA/TVARV tables as explained in How to maintain table 

entries for SAP Ariba Sourcing and SAP Ariba Contracts integration with SAP ERP [page 92].

Note
For a list of parameters that you need to maintain in the /ARBA/TVARV table for the SAP Ariba Supplier 
Information and Performance Management integration with SAP ERP, see Configuring the integration of 
SAP Ariba Supplier Information and Performance Management with SAP ERP and MDG [page 50].

● Specify the system ID of SAP ERP on the Service Manager Site Manager Customer Site Master 
Data Manager External System Configuration Create External System  window of the SAP Ariba 
Sourcing application.

● Based on the security model you choose, configure one of the following:
○ If you are using Shared Secret-based authentication, configure the Shared Secret settings in the 

Service Manager Site Manager Customer Site Integration Manager Integration Toolkit 
Security  window of the SAP Ariba Sourcing application.

○ If you are using the certificate-based authentication, install the client certificates and configure the 
certificate settings at the Service Manager Site Manager Customer Site Integration Manager
Integration Toolkit Security  window of the SAP Ariba Sourcing application.

Note
SAP Ariba Sourcing does not support certificate-based authentication for bill of materials integration 
between SAP ERP and SAP Ariba Sourcing.

For more information on installing the certificate, see How to configure the client certificate for certificate-
based authentication [page 103].

● Install the SSL client certificates before running the master data. For more information, see How to install the 
SSL certificate [page 104].

● Create a logical file path for the ISMW_ROOT.

How to configure SOAMANAGER

Context

Complete the SOAMANAGER configuration to set up direct connectivity between the SAP Ariba application and 
SAP ERP. When you configure SOAMANAGER, specify the proxy and endpoint names. For the proxy and endpoint 
names, see Proxy names and URL access paths for sourcing, contracts, and supplier data integration [page 105]. 
Alternatively, see the feature documentation for values specific for the integration that you want to set up.
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Procedure

1. Go to transaction code SOAMANAGER.
2. In the Service Administration tab, click Web Service Configuration.
3. Specify the following Search Criteria:

○ In the Search By dropdown, select Consumer Proxy.
○ Select Contains from the options.
○ Enter the first few characters of the proxy name that you want to search for and click Search.

The Proxy Class page appears.
4. From the list of proxies, click the name of the proxy that you want to configure.

The Details of Consumer Proxy: <proxy name> page appears.
5. From the Configuration tab, click Create Logical Port. and select Manual Configuration.
6. Under General Configuration, specify the following:

○ Logical Port name.
○ Description
○ Check the Logical Port is Default check box.

7. Click Next.
The New Manual Configuration of Logical Port for Consumer Proxy <proxy name> page appears.

8. From the Authentication Settings, select one of the following options:

○ If you plan to use Shared Secret-based authentication, select User ID/Password, and enter the User ID 
and the Password in the corresponding fields that appear.

Note
User ID is the name of the sourcing realm and the password the shared secret that you configured in 
the Ariba application.

○ If you plan to use client certificate-based authentication, select X 509 SSL Client Certificate, and specify 
the certificate file in the SSL Client PSE of transaction STRUST field.

9. Click Next.

The Transport Bindings page appears.
10. In the Transport Bindings page, specify the following:

○ URL Access Path. Realm name in the URL access path should be the same name that you maintain in the 
AUTH_PARAM table.

○ Computer Name of Access URL: Specify the path to your Ariba application.
For example, s1.ariba.com.
If you are using client certificate-based authentication, enter certs1.ariba.com.

○ Port Number of Access URL: 443
○ URL Protocol Information: HTTPS

11. Save changes.
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Next Steps

● For purchase info record integrations, after you complete the SOAMANAGER configuration, you must edit the 
logical port to set the Message ID Protocol to Suppress ID Transfer.

How to configure LPCONFIG for SAP ERP EhP4 and earlier 
versions

Context

Note
SAP Ariba Supplier Information and Performance Management is supported only on SAP ERP EhP6 and later 
versions.

Procedure

1. You must create a new RFC connection. For more information, see Creating a New RFC Connection [page 
103].

2. From SAP ERP, run the transaction code LPCONFIG.

3. Search for the proxy class that you want to associate the logical ports with.
The Display/Create Logical Port page appears.

4. Enter the port name in the Logical Port field.
5. Click Create.
6. Enter a description for the logical port.
7. Select the Default Port check box.
8. In the General Settings > Runtime tab, click Web Service Infrastructure.
9. Click the Call Parameters tab and select HTTP Destination.
10. Specify the newly created RFC destination.
11. Select the Operations tab. You can see the newly-generated proxy.
12. In the SOAP Action field, enter the following URL:

http://<Path to your Ariba applcation>/Sourcing/fileupload?realm. For example, https://
svcmachss.ariba.com/Sourcing/fileupload?realm=s4All.

13. Save and activate the entries.
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Creating a New RFC Connection

Context

Create a new RFC Connection before you configure the LPCONFIG for SAP ERP EhP4 and earlier versions.

Procedure

1. Go to transaction code sm59.

The Configuration of RFC Connection page appears.
2. Click to select HTTP Connection to External Server.
3. Click Create.

The RFC Destination page appears.
4. Click the Connection Type check box and select the G connection type.
5. Enter a description in the Description 1 text box.
6. Click the Technical Settings tab.
7. Enter values in the following fields: .

○ 1. Target Host: Enter the host name of the Ariba procurement system
2. Path Prefix: Enter the URL of the Ariba procurement solution system -http://<Path to your Ariba 

procurement solutions>/Buyer/fileupload?realm name <realm name that you maintain in SM30>. 
For example, https://s1.ariba.com/Buyer/fileupload?realm=p2pTeSap.

8. Click the Logon & Security tab.
9. Click Basic Authentication.
10. In the Logon section enter the following:

○ 1. User ID: Enter the user name for the procurement realm. For example, ERP2PTESAP_T.
2. Password: Enter the shared secret that you specified on the Integration Toolkit Security page of 

your Ariba Buyer system..

How to configure the client certificate for certificate-based 
authentication

Procedure

1. Ensure that you have the client certificate that you have received from an Ariba-trusted Certificate Authority.
2. Import the private key of the certificate into the SAP Business Site system by using the Trust Manager 

(transaction STRUST). You can only import certificates in the Personal Security Environment (PSE) format. 
Certificates in other formats must be converted to the PSE format. Use the command line tool SAPGENPSE to 
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do the conversion. Install the SAPGENPSE tool with the SAP Cryptographic Library installation package. For 
more information, see The SAP Cryptographic Library Installation Package [external document].

For example, to convert the P12 (Public-Key Cryptography Standards) format to PSE format, enter the 
following command line:

sapgenpse import_p12 -v -r <root certificate> -p <Target PSE file><Source File>.
1. Create a new Client Identity in the Trust Manager. Go to Environment > SSL Client Identities.

○ Enter ARIBA as the identity name and Ariba Network Client as the description.
○ Save the entries.

2. Import the private key of the certificate into the SAP Business Site system by using Trust Manager 
(transaction STRUST).
○ Select the newly-created ARIBA SSL Client ID and choose PSE > Import to import the PSE file.
○ Enter the password for the certificate if required.
○ To save, click PSE > Save as > SSL Client.
○ Enter ARIBA as the SSL Client.
○ Navigate to the Own Certificate group box on the Trust Manager screen, and double click the 

certificate to add it to the certificate list. You can now see the newly-added certificate in the 
Certificate List of Trust Manager.

3. Import the root certificate into the SAP Business Site system by using Trust Manager as follows:

1. Double-click the SSL Client Identity ARIBA that you have created.
2. Navigate to the Certificate group box and choose Import certificate. Click Add to Certificate List to add 

the imported certificate to the certificate list.
4. Use transaction SMICM to activate the changes and restart the Internet Communication Manager (ICM). Click 

Administration ICM Restart Yes . For more information, go to the SAP documentation portal and 
search for the phrase Using the ICM Monitor.

How to install the SSL certificate

Context

Install the SSL certificate to set up HTTPS connectivity. For information about the proxy names to configure, see 
Proxy names and URL access paths for sourcing, contracts, and supplier data integration [page 105]. 
Alternatively, see the feature documentation for values that are specific for the integration that you want to set up.

Procedure

1. Open your browser in Internet Explorer or Google Chrome and download the client certificate for the URL that 
you have configured in SOAMANAGER.

2. Click the Secure Lock indicator on the address bar and then click the Connection tab.
3. Click the Certificate information link to download the certificates.

The Certificate dialog box appears.
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4. Click the Details tab and then click Copy to File. The Certificate Export Wizard appears.
5. Follow the steps in the Certificate Export Wizard. Ensure that you select the DER encoded binary X.509 

(.CER) option. This option is selected by default.
6. Specify the path where you want to store the certificates. Click Finish.
7. On your ERP system, go to STRUST and click SSL Client SSL Client(Anonymous).
8. Click the Import Certificates button and then choose the path where you exported the certificates.
9. Click Allow and then Continue to download the certificates.
10. Click Add to Certificate List.

You will see a message that you have added the certificates successfully.

Note
Ensure that you save the newly-added certificates. This notifies the ICM about the new certificates you have 
just imported.

11. After you have saved the entries in the STRUST, go to the Tcode SMICM.

12. On the Administration menu, click ICM > Exit Soft and then Global.
13. In the Internet Communication Manager dialog box, Do you really want to restart all ICM processes in the 

system?, click Yes.
14. On the Administration menu, click ICM > Exit Hard and then Global.
15. In the Internet Communication Manager dialog box, Do you really want to restart all ICM processes in the 

system?, click Yes
16. Test your connection using the SOAMANAGER.
17. On the Search tab, select Consumer Proxy in the Search By pull-down list.
18. In the Search Pattern field, enter the first few letters of the proxy. From the Field dropdown, choose Both 

Names.
19. From the list of proxy names that appear, choose the proxy names.
20.On the Configurations tab, click Ping Web Service.

○ In case you see an ICM_HTTP_SSL_ERROR, verify that the SSL certificate is valid and the configuration is 
correct.

○ If the connection is successful, you see a message saying the connection is successful.

Proxy names and URL access paths for sourcing, contracts, 
and supplier data integration

The following table lists various master data integrations and the corresponding proxy names. The table also 
provides examples for endpoint URLs:

Integration Proxy name URL access path

SIPM outbound /ARBA/CO_SI_SOURCING_UPLOAD /Sourcing/fileupload?
realm=<realmname>
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Integration Proxy name URL access path

SIPM inbound /ARBA/
CO_SI_SOURCING_DOWNLOAD

/Sourcing/filedownload?
realm=<realmname>

Master data /ARBA/CO_SI_SOURCING_UPLOAD /Sourcing/fileupload?
realm=<realmname>

Purchase info record /ARBA/
CO_SI_PURCHASE_INFO_RECO

/dms/ws/PIRRequests?
realm=<realmname>

Purchase info record /ARBA/
CO_SI_PURCHASE_INFO_REC1

/dms/ws/PIRRequests?
realm=<realmname>

Bill of materials /ARBA/
CO_SOURCNG_BOMUPLOAD_OUT

/dms/ws/BOMRequests?
realm=<realmname>

Supplier Management polling client /ARBA/
CO_POLLING_CLIENT_REQRES

/SM/soap/PollingService

Supplier Management outbound integra­
tions from SAP ERP

CO_MDG_BP_RPLCTRQ /SM/soap/
BPIntegrationServiceIn

Supplier Management outbound confir­
mations from SAP ERP

CO_MDG_BP_RPLCTCO /SM/soap/
BPIntegrationServiceInConf

Configuring mediated connectivity
This section contains the following topics:

In this section:

About integrating master data using the mediated connectivity integration method [page 107]

Requirements [page 107]

Error handling [page 110]

How to configure the proxy on SAP ERP systems [page 111]

How to configure the proxy for single stack (Java only) instances for SAP Process Integration 7.3 and higher 
[page 112]

Configuring client certificates to import master data directly [page 113]

How to configure certificates and keys to import master data using the SAP Process Integration layer [page 
115]

How to configure the shared secret authentication [page 115]

Configuring the integration scenario [page 116]
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About integrating master data using the mediated 
connectivity integration method

Note
This topic applies to the the material master data integration and SAP ERP integration with SAP Ariba Supplier 
Information and Performance Management. For information about the Mediated Connectivity integration of 
contracts master data, see Installing and configuring the integration of contract information with SAP ERP 
[page 32].

Buyers using an SAP Ariba application integrated with SAP can integrate master data directly from an SAP ERP 
system to the SAP Ariba application system seamlessly using the SAP NetWeaver PI layer through the Mediated 
Connectivity Integration Method. This provides enhanced security while transferring master data from an SAP ERP 
system to an SAP Ariba application system. SAP Ariba downloads master data from an SAP ERP system to the 
SAP Ariba application through the SAP Process Integration using SOAP messages. Buyers can use either the 
shared secret or client certificate-based authentication.

To integrate master data, a buyer can use either client certificates or shared secret authentication to connect to 
the SAP Ariba application through the SAP Process Integration.

If you are using the client certificate, the SAP Process Integration keystore stores the certificates and keys that 
you create in SAP NetWeaver. You can create a view to group these certificates and keys based on views. For more 
information, see How to configure certificates and keys to import master data using the SAP Process Integration 
layer [page 115].

If you are using the shared secret authentication, you must configure the shared secret in the Communication 
Channel of your SAP Process Integration system. For more information, see How to configure certificates and keys 
to import master data using the SAP Process Integration layer [page 115].

Note
Buyer using the SAP Ariba application can also choose to integrate master data from an SAP ERP system to the 
SAP Ariba application directly. For more information, see Installing and configuring the integration of contract 
information with SAP ERP [page 32].

Requirements

Prerequisites

You must download and export the transport requests into your SAP ERP system. Ensure that you do the 
following:

● If you choose to directly integrate the master data to the SAP Ariba application using the SAP Process 
Integration:
○ Install client certificates if you use the client certificate authentication. You must get a client certificate 

from a Certificate Authorities that is trusted by SAP Ariba.
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○ The shared secret field in the /ARBA/AUTH_PARAM must be left empty if you are integrating master data 
directly using the client certificate authentication. However, you must ensure that the Realm and Wait(in 
minutes) are configured.

○ Do not create the logical port for the consumer proxy in the SOAMANAGER: MIOut_Sync_AribaUpload.

Note
○ The shared secret is no longer stored in the /ARBA/AUTH_PARAM table on the SAP ERP system. 

However, customers must specify a user name and password in the SOAMANAGER.
○ Enter the following consumer Proxy classes:

○ To upload files to SAP Ariba Contracts and SAP Ariba Supplier Information and Performance 
Management: /ARBA/CO_SI_SOURCING_UPLOAD 

○ To download files from SAP Ariba Contracts: /ARBA/CO_SI_SOURCING_DOWNLOAD.

● To support Transport Layer Security, TLS version 1.1 and TLS version 1.2, on mediated connectivity, 
implement SAP Note: 2284059-Update of SSL library within NW Java server.

Note
In the step 5 of the note, ensure that you specify the following values:

○ Legacy URL: client.minProtocolVersion (default: TLS10)
○ Advanced URL: client.maxProtocolVersion (default: TLS11 OR TLS12)

The following table provides a comparison between legacy and advanced URLs for SHA-2 certificates:

Table 4: SAP Ariba SHA-256 (commonly known as SHA-2) certificates

Data Center Legacy URLs (RSA) Advanced URLs (RSA)

US ○ s1.ariba.com
○ certs1.ariba.com
○ service.ariba.com
○ certservice.ariba.com

○ s1-2.ariba.com
○ certs1-2.ariba.com
○ service-2.ariba.com
○ certservice-2.ariba.com

EU service-eu.ariba.com ○ s1-2-eu.ariba.com
○ certs1-2-eu.ariba.com
○ service-2.ariba.com

RU ○ s1-ru.ariba.com
○ certs1-ru.ariba.com
○ service-ru.ariba.com

○ s1-2-ru.ariba.com
○ certs1-2-ru.ariba.com
○ service-2.ariba.com

Tip
To enhance the level of security, restrict the cipher suite support to a limited set of cipher suites that 
provide the highest level of security.

○ TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
○ TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
○ TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
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○ TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA
○ TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
○ TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA
○ TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256
○ TLS_DHE_RSA_WITH_AES_256_GCM_SHA384
○ TLS_DHE_RSA_WITH_AES_128_GCM_SHA256
○ TLS_DHE_RSA_WITH_AES_256_CBC_SHA256
○ TLS_DHE_RSA_WITH_AES_256_CBC_SHA
○ TLS_DHE_RSA_WITH_AES_128_CBC_SHA256
○ TLS_DHE_RSA_WITH_AES_128_CBC_SHA
○ TLS_DHE_RSA_WITH_CAMELLIA_256_CBC_SHA
○ TLS_DHE_RSA_WITH_CAMELLIA_128_CBC_SHA
○ TLS_DHE_DSS_WITH_AES_256_CBC_SHA256
○ TLS_DHE_DSS_WITH_AES_128_CBC_SHA256
○ TLS_DHE_DSS_WITH_AES_256_CBC_SHA
○ TLS_DHE_DSS_WITH_AES_128_CBC_SHA
○ TLS_RSA_WITH_AES_256_GCM_SHA384
○ TLS_RSA_WITH_AES_128_GCM_SHA256
○ TLS_RSA_WITH_AES_256_CBC_SHA256
○ TLS_RSA_WITH_AES_256_CBC_SHA
○ TLS_RSA_WITH_AES_128_CBC_SHA256
○ TLS_RSA_WITH_AES_128_CBC_SHA
○ TLS_RSA_WITH_CAMELLIA_256_CBC_SHA
○ TLS_RSA_WITH_CAMELLIA_128_CBC_SHA
○ TLS_RSA_WITH_3DES_EDE_CBC_SHA
○ TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256
○ TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

Requirements for the SAP Process Integration

The following are the changes required to be configure the integration scenario in the SAP Process Integration to 
integrate master data:

● Software component ARIBA_UPLOAD 1.0 of ariba.com in the System Landscape Directory (SLD).
● NameSpace for the software component:

○ Outbound:http://ariba.com/xi/AribaUpload
○ Inbound:http://ariba.com/xi/AribaDownload

● SOAP receiver Communication Channel Templates:
○ Outbound:CCT_AribaSourcingUpload_Receive
○ Inbound:CCT_AribaSourcingDownload_Receive

● Data Types for the request and response:
○ Outbound:DT_UploadReq
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○ Inbound:DT_UploadRes
● Message Types for the request and response:

○ Outbound: MT_UploadReq
○ Inbound:MT_UploadRes

● Service Interfaces for the inbound and outbound messages:
○ Outbound:SI_SourcingUpload_Sync_In and SI_SourcingUpload_Sync_Out 
○ Inbound:SI_SourcingDownload_Sync_In and SI_SourcingDownload_Sync_Out 

● Actions for the outbound proxy action and SOAP receiver action: OutboundProxy and SOAPReceiver 
● Process Integration Scenario Object:

○ Outbound: AR_AribaSourcing_Upload
○ Inbound:AR_AribaSourcing_Download

For more information, see Configuring the integration scenario [page 116].

Requirements for SAP ERP

The following are the changes required in the SAP ERP to integrate master data:

● Set up the proxy configuration between the SAP ERP and SAP Process Integration to generate the proxy 
objects, send and receive the proxy request and response messages. For more information, see How to 
configure the proxy on SAP ERP systems [page 111] and How to configure the proxy for single stack (Java 
only) instances for SAP Process Integration 7.3 and higher [page 112].

Limitations

This feature has the following limitations:

● Administrators do not get email notifications when an error occurs during the master data integration.
● Administrators can only view the log files in the runtime monitor of the SAP ERP and SAP Process Integration.
● The log files do not store a record of all the error conditions in the SLGI.

Backward Compatibility

This feature is compatible with previous versions of the SAP Ariba cloud integration releases.

Error handling

System errors faced while exporting master data directly 

System error can occur either when data is sent from the ERP system to the Process Integration or from the 
Process Integration to the NetWeaver system. An administrator can monitor the errors from the SXMB_MONI if a 
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system error occurs while sending the data from the ERP system to the Process Integration . The monitor of the 
NetWeaver system displays the error when the data is sent from the Process Integration to the NetWeaver 
system.

When a system error occurs, the ABAP program tries to upload the master data up to three times based on the 
time delay specified in the /ARBA/AUTH_PARAM table. If it still fails, the master data is not lost and is available on 
the SAP ERP server. To retrieve the master data, the administrator must make the necessary changes to the 
configuration (RealmID, shared secret, or URL) based on the error and run the Full or Incremental Load exports for 
the master data tasks again from your ERP system.

When exporting the master data, the data is posted on the SAP Ariba application. The data validation does not 
occur immediately on posting the data but later. When there are data dependencies or inconsistencies, an error is 
recorded on the SAP Ariba application.

Administrators can check errors using the following methods:

1. Configure email notification alerts on their SAP Ariba application system to receive notification when an error 
occurs. This enables the administrator to log in to the SAP Ariba application to check the details of the errors.

2. Directly log in to the SAP Ariba application and check the details of the errors.

To correct the error, the administrator must ensure that the data inconsistency is resolved in ERP system and then 
must rerun the tasks for the master data again from the ERP system.

Note
Buyers can also manually run the master data import tasks.

Single Stack

To view errors in a single stack instance, go to the Configuration and Monitoring Home>Adapter 
Engine>Message Monitor page.

Dual Stack

To view errors in a dual stack instance, go to the SXMB_MONI page.

How to configure the proxy on SAP ERP systems

Procedure

1. Run the transaction SM59 and check if following configurations exist:

○ SAP_PROXY_ESR under HTTP Connections to External Server
○ XI_INTEGRATIONSERVER_<SID> (SID - system identifier) under HTTP Connections to ABAP 

System (H Type RFC)
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○ LCRSAPRFC under TCP/IP Connections. Specify the program ID similar to the one created under Jco 
RFC destinations (LCRSAPRFC_<SID>, where SID - system identifier)

○ SAPSLDAPI under TCP/IP Connections. Specify the program ID similar to the one created under Jco RFC 
destinations (SAPSLDAPI_<SID>, where SID - system identifier)

2. Start transaction SLDAPICUST.
3. Enter SAP XI hostname, port, XI user ID, and password.
4. Start transaction SXMB_ADM.
5. Expand Integration Engine> Configuration.
6. Click Integration Engine Configuration to edit global configuration data.
7. In the Global Configuration Data section, enter the following:

○ Role of Business System: Application System
○ Corresponding Integ. Server: dest://<XI_INTEGRATIONSERVER_PPI>

This is the same H Type RFC destination mentioned in Step 1.
8. Run SLDCHECK command in SAP ERP.

The Process Integration server appears and the Summary section indicates that the connection to XI is 
successful.

How to configure the proxy for single stack (Java only) 
instances for SAP Process Integration 7.3 and higher

Procedure

1. Run the transaction SM59 and create RFC destination SAP_PROXY_ESR (Type G) under HTTP Connections 
to External Server.

1. Under the Technical Settings tab, add AEX (PI Java Stack) server host name and port.
2. In the Path Prefix field, enter /rep.
3. Under the Logon & Security tab, you must ensure that the user is assigned to the role 

SAP_XI_REP_SERV_USER.

2. Create an HTTP destination to AEX of Type G (example: PI_AEX) as follows:

1. Under the Technical Settings tab, add AEX (PI Java Stack) server host name and port.
2. In the Path Prefix field, enter /XISOAPAdapter/MessageServlet?ximessage=true.
3. Under the Logon & Security tab, user must be assigned to role SAP_XI_REP_SERV_USER.

3. Start transaction SXMB_ADM.
4. Expand Integration Engine > Configuration.
5. Click Integration Engine Configuration to edit global configuration data.
6. Under Global Configuration Data, enter:

○ Role of Business System: Application System
○ Corresponding Integ. Server: dest://<PI_AEX>

This is the same G Type RFC destination mentioned in step 2.
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7. Click Specific Configuration and enter the following:

○ Category: Runtime
○ Parameter: IS_URL
○ Current Value: dest://<PI_AEX>

This is the same G Type RFC destination mentioned in step 2.
8. Start transaction SLDAPICUST.
9. Enter SAP XI hostname, port, XI user ID, and password.
10. Run SLDCHECK command in SAP ERP.

Configuring client certificates to import master data 
directly

Procedure

1. Ensure that you have the client certificate that you have received from an SAP Ariba trusted Certificate 
Authority.

2. Import the private key of the certificate into the SAP Business Site system by using the Trust Manager 
(transaction STRUST)..You can only import certificates in the Personal Security Environment (PSE) format. 
Certificates in other formats must first be converted to the PSE format. Use the command line tool 
SAPGENPSE to do the conversion. Install the SAPGENPSE tool with the SAP Cryptographic Library 
installation package. For more information, see The SAP Cryptographic Library Installation Package [external 
document].

For example, to convert the P12 (Public-Key Cryptography Standards) format to PSE format, enter the 
following command line:

sapgenpse import_p12 -v -r <root certificate> -p <Target PSE file><Source File>.

1. Create a new Client Identity in the Trust Manager. Go to Environment > SSL Client Identities.
○ Enter “ARIBA” as the identify name and “Ariba Network Client” as the description.
○ Save the entries.

2. Import the private key of the certificate into the SAP Business Site system by using the Trust Manager 
(transaction STRUST).
○ Select the newly created ARIBA SSL Client ID and choose PSE > Import to import the PSE file.
○ Enter the password for the certificate. if required.
○ To save, click PSE > Save as > SSL Client.
○ Enter “ARIBA” as the SSL Client.
○ Navigate to the Own Certificate group box on the Trust Manager screen, and double-click the 

certificate to add it to the certificate list. You can now see the newly added certificate in the 
Certificate List of the Trust Manager.

3. Import the root certificate into the SAP Business Suite system by using Trust Manager as follows:

1. Double-click the SSL Client Identity ARIBA that you have created.
2. Navigate to the Certificate group box and choose Import certificate. Click Add to Certificate List to add 

the imported certificate to the certificate list.
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4. Obtain the server certificate from SAP Ariba for the HTTPS SSL encryption:

1. Go to https:\\svcmachss.ariba.com.
2. Download the certificate using your browser.

For example, if you are using Internet Explorer, go to Internet Explorer, click View>Security Report>View 
Certificates. On the Details tab, click Copy to File and export it in the Base-64 encoded X.509 format.

3. Import the server certificate into the SAP Business Suite system using Trust Manager.
4. Double click the ARIBA SSL Client ID that you have created.
5. Navigate to the Certificate group box and choose Import certificate. Add the imported certificate to the 

certificate list by clicking Add to Certificate List.
5. Use transaction SMICM to activate the changes and restart the Internet Communication Manager (ICM). Click 

Administration > ICM > Restart > Yes. For more information, go to the SAP documentation portal and search 
for the phrase “Using the ICM Monitor.”

6. Go to TCode SOAMANAGER to configure the Web services.

1. Click Web Service Configuration.
2. In the Design Time Object Search tab, search for CO_SI consumer proxy.
3. In the Search Result section, click /ARBA/CO_SI_SOURCING_UPLOAD.
4. In the Configurations tab, click Create and then click Manual Configuration to create a manual logical 

port.
5. In the Logical Port Name text box, enter a name for the logical port.
6. Enter a description in the Description text box.
7. Click the Logical Port is Default checkbox.
8. Click Next.
9. On the Consumer Security page, select the X.509 SSL Client Certificate and then click X.509 SSL 

Client Certificate.
10. Enter “Ariba” in the SSL Client PSE of transaction STRUST text box and click Next.
11. On the HTTP Settings page, enter the URL Access Path, Computer Name of Access URL, Port number 

of Access URL and URL Protocol Information.

Note
If you choose HTTPS as the URL Protocol Information, ensure that you enter “443.” If you choose 
HTTP, enter “80.”

12. Click Finish.
13. Ping the web service URL. The following error message appears: “Web service ping failed. (RC=403. 

Service Ping ERROR Forbidden.”
7. Log in to your SAP Ariba buyer account. Go to Core Administrator > Integration Tool Kit Security. The 

Integration Toolkit Security page appears.
8. In the Select the Authentication Method pull-down menu, choose Certificate. Paste the contents of the 

public certificate.

Note
If you are integrating master data directly using the client certificate authentication, you must leave the 
shared secret field in the /ARBA/AUTH_PARAM empty.
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How to configure certificates and keys to import master 
data using the SAP Process Integration layer

Procedure

1. Go to SAP Process Integration NetWeaver Administration , and then click Configuration 
Management.

2. Click Certificate and Keys.
3. On the Certificate and Keys page, click Create to create a new view. Create the required keys and certificates 

for the newly created view.

Note
Ensure that your required certificates are signed by an SAP Ariba trusted Certificate Authority to 
successfully establish the SSL connection.

4. Go the SOAP Receiver Communication Channel page and in the General tab, click the Configure Certificate 
Authentication check box.

5. In the Keystore Entry field, select the key newly created in the keystore.
6. In the Keystore View field, select the newly created view in the keystore.
7. In the Target URL field, ensure that you specify the location of the certificates stored on your SAP NetWeaver 

Administrator system.

Note
Ensure that your URL starts with “https://cert...

8. Save and activate the communication channel.
9. Log in to your SAP Ariba buyer account. Go to Core Administrator > Integration Tool Kit Security. The 

Integration Toolkit Security page appears.
10. In the Select the Authentication Method dropdown, choose Certificate. Paste the contents of the client 

certificates.

How to configure the shared secret authentication

Procedure

1. Open the Configuration Integration Builder from the SAP Process Integration main page.
2. In the Objects tab of the Integration Builder, click Communication Channel.
3. Click Edit button that corresponds to the Communication Channel, and click Configure User Authentication.
4. In the Target URL field, specify the URL of your Sourcing system. For Example:

○ For material master, material classification, and Manufacturer Parts List: http://<URL to your SAP Ariba 
Sourcing solutions>/Sourcing/fileupload?realm <realm name that you maintain in SM30> for example, 
https://s1.ariba.com/Sourcing/fileupload?realm=s4All.
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○ For bill of materials: https://<URL to SAP Ariba Sourcing>/dms/ws/BOMRequests?realm=<realm name 
that you maintain in SM30>.

5. In the User text box, enter the realm name for your Sourcing system.
6. In the Password text box, enter the same shared secret that you specified on the Integration Toolkit Security 

page of your SAP Ariba Sourcing system.
7. Save and activate the communication channel.

Configuring the integration scenario

Procedure

1. From the SAP Process Integration main page, select Integration Directory > Integration Builder, and then 
login to the Configuration: Integration Builder application.

2. In the Integration Builder page, select Tools > Apply Model from ES Repository.
3. In the first screen of the Transfer Model from ES Repository wizard > Select ES Repository Model and then 

click Process Integration Scenario.
4. Click the Name field and then click the Display Input Help pull-down menu and then click Input Help.
5. Select the one of the following values from the Select Process Integration Scenario from Enterprise 

Services Repository screen:

○ AR_AribaSourcing_Upload for export.
○ AR_AribaSourcing_Download for import.

6. Click Apply. The Transfer Model from ES Repository wizard appears. The Namespace and the Software 
Component Version is available in the wizard.

7. Click Continue and then click Close. Based on the value you set in the Select Process Integration Scenario 
from Enterprise Services Repository field, this completes the export or import configuration scenario .

8. In the Model Configurator, click the Select Component View button.
9. In the Select Component View for Configuration page, select the Business System Components for A2A 

tab to assign components for your SAP Ariba Buying solutions.
10. Click the Insert Line button ('+') to add a component entry in the table if no component entry line is present.
11. Click the row under the Communication Component column, then click the Value List drop down and select 

Value List ..F4. Select the communication component name AR_AribaSourcing_Upload (for export) or 
AR_AribaSourcing_Download (for import) from the selection list and click Apply.

12. Click the Assign Component button.
13. In the Model Configurator page, select the Business System Components for A2A tab to assign the 

communication component for your SAP Ariba Buying solutions.
14. Click the row under the Communication Component column, then click the Value List pull down menu and 

select Value List <F4>. Select the communication component name from the selection list and click Apply..
15. Click the Next Application Component button (the right arrow) to go to the next screen in the window.
16. Click the Insert Line button (’+’) to add a component entry in the table if no component entry line is present.
17. Click the row under the Communication Component column, then click the Value List pull-down and select 

Value List ..F4. Select the communication component name for the business system from the selection list 
and click Apply.
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18. Click the Save Settings button to save the changes.
19. In the Model Configurator page, click the Configure Connections button. You must assign a Communication 

Channel to set up the connections.
20.In the Connections from Component Assignment tab, click the empty Communication Channel cell 

corresponding to the to the business system component value.
21. Click the Value List pull down menu and select Value List ..F4. Select the communication component and 

click Apply.
22. Select the CC_Proxy_Sender communication channel from the selection list and click Apply.

Note
You require the Proxy Sender communication channel only for a single stack Java machine. If you are using 
a dual stack Java machine, the Communication Channel cell must be left blank.

23.Click the New Communication Channel button (the icon at the top left) on the Communication Channels 
page to start the Create Communication Channel wizard.

24.Click Continue and in the next page click the Name field, then click the Display Input Help drop down list and 
select Input Help. Select the following Communication Channel Template:

○ Communication Component: Specify the communication component.
○ Communication Channel: Specify the communication channel.

25. Click Finish. The Model Configurator window appears.
26.In the Model Configurator, click the Create Configuration Object button.
27. In the Create Configuration Object window, do the following:

○ Click Generation in the General section.
○ Select the Receiver Determination, and Interface Determination checkboxes in the Scope of 

Generation section.
28.Click Create New in the Change List for Generated Objects section. The text box already contains an object 

name that you can use or modify.
29.Click Start to begin generating objects.
30.After the object generation is complete, click Apply to save the new configuration settings. Close the log that is 

created without saving. You can save it, if required.
31. On the Communication Channel page, you can specify the shared secret or client certificate authentication in 

the Parameters tab. Ensure that you set the parameters in the General tab>Connection Parameters section 
that matches your Ariba Buyer account configuration.

32.Save the changes.

Remember
The proxy settings and the subsequent reflection of Ariba_Upload ESR object in the SAP ERP SPROXY 
transaction is done for integrating master data through the Process Integration layer. By default, the 
connectivity is always direct through SOAMANAGER.
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Revision history

The following table provides a brief history of the updates to this guide. SAP Ariba updates the technical 
documentation for its cloud solutions if

● software changes delivered in service packs or hot fixes require a documentation update to correctly reflect 
the new or changed functionality;

● the existing content is incorrect or user feedback indicated that important content is missing.

SAP Ariba reserves the right to update its technical documentation without prior notification. Most documentation 
updates will be made available in the same week as the software service packs are released, but critical 
documentation updates may be released at any time.

Cloud inte­
gration re­
lease

Month/year of 
update

Updated chapter/
section

Short description of change

9.0 December 2016 n/a Reset revision history for Cloud Integration Release 9.0.

Multiple Chapters Ariba Cloud Integration Release 9.0

Updated throughout for the Ariba Cloud Integration Release 9.0.

January 2017 About this guide Added a pointer to the Installation Guide for Sourcing, Contracts, 
and Supplier Data Integration with SAP ERP.

About integrating 
sourcing, contract, 
and supplier data 
with SAP ERP

Added a new chapter.

March 2017 Configuring Medi­
ated Connectivity

Added TLS version 1.1 and TLS version 1.2 support on mediated 
connectivity

9.0 SP1 March 2017 Integrating Contract 
Information with 
SAP ERP

Added a limitation for service line item hierarchies.

April 2017 ● Enhancements 
to Ariba Sourc­
ing integration 
for Product 
Sourcing

● How to include 
additional infor­
mation in the 
SLG1 log files

Added information on the optional parameter for storing AML and 
BOM information in the SLG1 log files.
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Cloud inte­
gration re­
lease

Month/year of 
update

Updated chapter/
section

Short description of change

Enhancements to 
SAP Ariba Sourcing 
integration for prod­
uct sourcing

Added information about filtering option when performing incre­
mental upload for Manufacturer Parts List and Approved Manufac­
turer Parts List.
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Important Disclaimers and Legal Information

Coding Samples
Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system 
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and 
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP 
intentionally or by SAP's gross negligence.

Accessibility
The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a 
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does 
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language
As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales 
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not 
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks
The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not 
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages 
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see: 
http://help.sap.com/disclaimer).
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